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Welcome

We hope you share our dream for the television industry to become a truly creative
industry by allowing anyone to have access to the highest quality video.

Our range of HyperDeck disk recorders have made it easier and more affordable than
ever to record and play back full 10 Bit uncompressed video and now Ultra HD 4K!
HyperDeck records directly to removable 2.5” Solid State Disks (SSDs) that are getting
bigger, faster and more affordable every day. It's incredible that you can now record
and play the most amazing quality video onto something so small thousands of times
without any degradation in quality!

SSDs can also be mounted on any computer for immediate editing and fast transfer
of your media. With no moving parts, SSDs are unbelievably robust and can handle
harsh conditions that would destroy conventional hard drives and videotapes!

You can bypass unwanted camera compression and record directly from HDMI or
SDI cameras straight to SSD and even connect to any HDMI or SDI monitor for instant
playback! With HyperDeck Studio Pro, you can connect analog sources and also
record and play back Ultra HD 4K with 6G-SDI!

If you need longer recording times for each SSD, then HyperDeck also records and plays
back Apple ProRes and Avid DNxHD files. These 10 Bit quality codecs retain fantastic
picture quality and increase the recording length of SSDs by more than 5 times!

This instruction manual contains all the information you need to start using your
HyperDeck disk recorder. For uncompressed recording you need to use an SSD
that supports the required data speed and we are continually adding details on
our website of new SSDs that we have tested.

Please check the support page at www.blackmagicdesign.com for the latest version of this
manual and updates to the HyperDeck software. Keeping your software up to date will
always ensure you get all the latest features. WWhen downloading software, please register
with your information so we can keep you updated when new software is released. We are
constantly working on new features and improvements, so we would love to hear from you!

i

Grant Petty
CEQ Blackmagic Design
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Getting Started

HyperDeck Studio Pro

Introducing HyperDeck

There are three models of HyperDeck disk recorders, which all have internal 3 Gb/s SATA ports for use
with standard 2.5" SSDs.

HyperDeck Shuttle

HyperDeck Shuttle is compact, affordable and battery powered, so it's perfect as a field recorder.
HyperDeck Shuttle bypasses your camera’s compression and records from SDI and HDMI directly into the
highest quality uncompressed video. If compressed video better suits your workflow, or if you need to fit
more video on a SSD, the latest model records and plays back Apple ProRes and Avid DNxHD formats.

The HyperDeck Shuttle Mounting Plate can be purchased if you want to secure your HyperDeck Shuttle
to a camera rig with your choice of rail mounts, cold shoe mounts, articulated arms and more. You can
also use the plate to power your HyperDeck Shuttle from an external battery by attaching a V-Mount
or Anton Bauer style battery plate.

HyperDeck Studio

HyperDeck Studio is a rack mount broadcast deck style recorder that features dual SSD slots so it can
automatically continue recording onto another SSD when one is full. Only 1 RU high and less than 4
inches deep, HyperDeck Studio is perfect for when space is tight, such as in broadcast vans and fly
away rack cases.

HyperDeck Studio features uncompressed quality recording and playback, RS-422 deck control, genlock,
jog and shuttle controls and an integrated LCD. It can record and play back in Apple ProRes and Avid
DNxHD formats if compressed video better suits your workflow or if you need to fit more video on a
SSD. Both the HyperDeck Studio and the HyperDeck Studio Pro support the following ProRes codecs:

= Prores 422 (HQ)

* ProRes 422

* ProRes 422 LT

* ProRes 422 (Proxy)

HyperDeck Studio Pro

HyperDeck Studio Pro does everything that HyperDeck Studio does, with the addition of analog video
and audio in and out, timecode in and out, Thunderbolt™ connectivity, high 1080p frame rates including
50, 5994 and 60, and Ultra HD 4K ProRes capture and playback via 6G-SDI and HDMI 4K!
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HyperDeck Shuttle HDMI and SDI inputs.
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HyperDeck Studio Pro HDMI, analog component
and SDl inputs.

Plugging in Video Sources

HyperDeck Shuttle

Step 1.

Step 2.

Power on the unit. If HyperDeck Shuttle does not power on, you may need to charge the
battery. Simply plug in the power adapter and turn HyperDeck Shuttle on. The battery will
continue to charge as long as the power adapter is connected. You can also power it from
an external camera battery as the connector supports an input range of 12V to 18V.

Connect your SDI source to the DIN 1.0/2.3 miniature connector. You may need a BNC to
DIN 1.0/2.3 adapter cable for this. If your source is HDMI, connect a Type A HDMI cable
to the HDMI input. If you connect both SDI and HDMI, HyperDeck Shuttle will default to
recording from whichever input was connected first. We recommend having only SDI or HDMI
connected to each input as HyperDeck Shuttle will switch inputs if one is disconnected and
then reconnected.

HyperDeck Studio

Step 1.

Step 2.

Step 3.

Power the unit by connecting an IEC power cord with a C13 connector. HyperDeck Studio's
built in international AC power supply supports 110-240V, 50/60 Hz.

Connect SDI video sources, such as cameras, routers, switcher outputs or decks to the SDI
inputs. If your source is from HDMI, connect a Type A HDMI cable to the HDMI input.

Press the INPUT button once while the stop button is illuminated. The Input button will
illuminate and you will be able to preview the video source on the LCD. If you don't see the
video you want, press INPUT again to switch inputs.

HyperDeck Studio Pro

Step 1.

Step 2.

Step 3.

Step 4.

Power the unit by connecting an IEC power cord with a C13 connector. HyperDeck Studio
Pro's built in international AC power supply supports 110-240V, 50/60 Hz.

Connect SDI, HDMI or component sources to their respective inputs. If you are recording
Ultra HD 4K over SDI, the SDI inputs will automatically detect whether you are connecting
via single link 6G-SDI to Input A, dual link 3G-SDI or quad link HD-SDI.

If connecting analog audio sources, you can use the XLR inputs for professional balanced
analog audio or the stereo RCA connectors for unbalanced analog audio from consumer
equipment. Connect analog timecode to the XLR timecode input.

Press the INPUT button once while the stop button is illuminated. The Input button will
illuminate and you will be able to preview the video source on the LCD. If you don’t see the
video you want, press INPUT again to switch inputs.
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HyperDeck Studio SDI and HDMI outputs. SDI outputs
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HyperDeck Studio Pro HDMI, analog component and SDI
outputs plus Monitor Out.

The record button lights up red when HyperDeck Shuttle
is recording video.
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Connecting Video Outputs

HyperDeck features outputs for monitoring or connecting to additional recording units. All outputs are
active, so you can record and monitor simultaneously.

HyperDeck Shuttle

Connect either an SDI or HDMI cable to their respective outputs. You may need a DIN 1.0/2.3 to BNC
adapter cable for outputting SDI. Both outputs are active, so you can view your recording on both an
SDI monitor and an HDMI monitor simultaneously.

HyperDeck Studio

Connect an SDI cable to the Loop Out port if you want to connect to another HyperDeck for redundant
recording or to the Monitor output if you want to connect an SDI monitor. You can also connect additional
SDI equipment to the SDI outputs such as additional recorders or monitors.

HyperDeck Studio Pro

Connect SDI, HDMI or component analog cables to their respective outputs. If you want to output Ultra
HD 4K over 6G-SDI, use Output A. HDMI also supports Ultra HD 4K. For SD/HD-SDI monitoring, connect
to the Monitor output. You can also send analog timecode via the XLR timecode output.

Congratulations! You are now ready to start recording!

Recording Video

HyperDeck ships ready to record immediately without having to configure any settings. All you need is
arecommended SSD formatted in the HFS+ or exFAT format. If HyperDeck records from a video source
that contains closed caption data, the QuickTime or MXF movie will be recorded as well as a separate
.MCC file containing the closed caption data.

Recording Video with HyperDeck Shuttle

Step 1.  Insertyourformatted SSD. As HyperDeck Shuttle reads the disk, the SSD light will illuminate.
When the light goes off, HyperDeck Shuttle is ready to record.

Step 2. HyperDeck Shuttle automatically detects whether SDI or HDMI is connected. The Video
status LED lights up when a valid video signal is detected.

Step 3.  Pressthe Record button and the SSD light will flash to indicate SSD activity. If the Stop button
starts flashing while recording, there are only 3 minutes of recording time left on the SSD.
Make sure you have another empty SSD ready so you don't miss the next take.

Step 4.  Press the Stop button to finish recording.
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SSD slots on HyperDeck Studio models have rotating LEDs to
show the unit is recording video.
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The play button lights up green when HyperDeck Shuttle
is in playback mode.

Recording Video with HyperDeck Studio Models

Step 1.

Step 2.

Step 3.

Step 4.

Insert your formatted SSD into either SSD slot. The slot light will illuminate green as HyperDeck
reads the disk. When the slot light goes off, HyperDeck Studio is ready to record.

Press the INPUT button once while the stop button is illuminated. The Input button will
illuminate and you will be able to preview the video source on the LCD before recording.
If you don't see the video you want, press INPUT again to switch inputs.

Press the record button to start recording to the SSD instantly. A looping red light on the
SSD slot indicates the SSD is recording. During recording, you can press and hold the record
button to switch recording from one SSD to the other instantly.

Press the Stop button to finish your recording.

If the record button flashes, this means the disk is not fast enough and recording cannot keep up. We
recommend you change to a compressed recording format such as ProRes or DNxHD, or use a faster
recommended SSD for uncompressed or Ultra HD 4K recording.

Playing Video

The controls of HyperDeck work just like a CD player, so playing back clips is simple and instantaneous.
If you play back a video clip that has an associated .MCC file, the closed caption data will be played out
with the video via the SDI output of your HyperDeck.

Playing Video with HyperDeck Shuttle

Step 1.
Step 2.
Step 3.

Step 4.

Press the Stop button once to stop recording.
Press Stop again to switch HyperDeck Shuttle to playback mode.

Press Play and you'll see your video on any displays connected to the SDI and HDMI outputs.
When a clip is playing, pressing Play again will loop it continuously.

To skip to the next clip, press the next clip button on the shuttle controls. Press previous
clip once to go to the start of the current clip or press twice to skip back to the start of the
previous clip.

Playing Video with HyperDeck Studio models

Step 1.
Step 2.

Press the Stop button once to stop recording.

Press the play button once for instant playback and you'll see your video on any displays
connected to the SDI and HDMI outputs. When a clip is playing, pressing Play again will
loop it continuously.
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SSD slots on HyperDeck Studio models have rotating LEDs to
show the unit is in playback mode.
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Step 3.  To skip to the next clip, press the next clip button on the shuttle controls.

Step 4.  Press previous clip once to go to the start of the current clip or press twice to skip back to
the start of the previous clip.

If the play button flashes, this means the disk is not fast enough and playback cannot keep up. We
recommend you change to a compressed recording format such as ProRes or DNxHD, or use a faster
recommended SSD for uncompressed or Ultra HD 4K recording.

Congratulations! Your HyperDeck is now up and running. Please continue to the next sections of this
manual for more information on what you can do with your HyperDeck.
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Intel 335 Series 240GB SSD

Sandisk Extreme 480GB SSD

Kingston HyperX 240GB SSD
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About SSDs

Choosing a Fast SSD

When working with high data rate video it's important to carefully check the SSD you would like to use.
This is because some SSDs can have up to 50% lower write speed than the manufacturer’s claimed speed,
so even though the disk specifications claim an SSD is fast enough to handle video, in reality the disk is
not fast enough for real time video recording. Hidden data compression mostly affects recording and
often these disks can still be used for real time playback.

In our testing, we have found larger newer models of SSD and larger capacity SSDs are generally faster.
SSDs recommended for use with HyperDeck for uncompressed 10 Bit HD and ProRes Ultra HD 4K video
recording include:

= Crucial 512GB M4 (firmware 009 only)

* Digistor — 128GB SSD Professional Video Extreme
* Digistor — 240GB SSD Professional Video Series
* Digistor — 480GB SSD Professional Video Series
* Intel 335 Series 240GB SSD

* Intel 520 Series 240GB SSD

* Intel 520 Series 480GB SSD

* Kingston 120GB SSDNow V+200

= Kingston 240GB SSDNow V+200

* Kingston HyperX 240GB

= OCZ 240GB Deneva 2 (firmware 2.22)

+ OCZ 240GB Vertex 3

+ OCZ480GB Vertex 3

* OWC Mercury Extreme Pro 6G SSD

= PNY 240GB Prevail SSD (firmware 5.0.2)

*+ Sandisk Extreme 480GB

Please check the tech notes on the Blackmagic Design website for the latest information.

If you find an SSD that isn't fast enough for uncompressed HD video or Ultra HD 4K, try a faster SSD or
use HyperDeck Utility to switch to a compressed recording format such as ProRes or DNxHD. These
recording formats have a much lower data rate and are easier for the SSD to handle.
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Use Disk Utility on Mac OS X to erase your SSD in the
Mac OS Extended (Journaled) or exFAT format.
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Create an M5-D0S startup disk

Use the Format dialog box feature
in Windows to format your SSD
in the exFAT format.
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Preparing SSDs for HyperDeck

SSDs used by HyperDeck must be formatted as either HFS+ or exFAT. These disk formats allow long
clips to be recorded in single files.

HFS+ is also known as Mac OS Extended. It is the recommended format for HyperDeck as it supports
"journaling”. In the event of a hardware or software malfunction, data on a journaled SSD is more quickly
recovered and less likely to be corrupted in the first place. HFS+ is natively supported by Mac OS X.

EXFAT is supported natively by Mac OS X and Windows without needing to purchase any additional
software. However exFAT does not support journaling which means data is more prone to corruption,
and less likely to be recovered in the event of a hardware or software malfunction.

Preparing SSDs on a Mac OS X computer

The Disk Utility application included with Mac OS X can format a drive in the HFS+ or exFAT formats. Make
sure you back up anything important from your SSD as you will lose everything on it when it is formatted.

Step 1.  Connect the SSD to your computer with an external dock or cable adapter and dismiss any

message offering to use your SSD for Time Machine backups.
Step 2.  Go to Applications/Utilities and launch Disk Utility.
Step 3.  Click on the disk icon of your SSD and then click the Erase tab.
Step 4. Setthe Format to Mac OS Extended (Journaled) or exFAT.

Step 5. Type a Name for the new volume and then click Erase. Your SSD will quickly be formatted
and made ready for use with HyperDeck.

Preparing SSDs on a Windows computer

The Format dialog box can format a drive in the exFAT format on a Windows PC. Make sure you back
up anything important from your SSD as you will lose everything on it when it is formatted.

Step 1.  Connect the SSD to your computer.

Step 2.  Open the Start Menu or Start Screen and choose Computer. Right-click on your SSD.
Step 3.  From the contextual menu, choose Format.

Step 4. Set the file system to exFAT and the allocation unit size to 128 kilobytes.

Step 5. Type avolume label, select Quick Format and click Start.

Step 6.  Your SSD will quickly be formatted and made ready for use with HyperDeck.
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HyperDeck Utility

Blackmagic HyperDeck Utility is used to change settings and update the internal software in your
HyperDeck. In addition to installing HyperDeck Utility, uncompressed 10 bit codecs are installed for Mac
and Windows. The HyperDeck Installer software also installs Blackmagic System Preferences, which allow
your favorite video editing software to perform live capture from HyperDeck Studio Pro via Thunderbolt.

Blackmagic system preferences provide a central location so you don't need to configure the same
software settings in each video application that you use.

On Mac OS X, open the System Preferences and click the Blackmagic Design icon. When using HyperDeck
Studio Pro, settings are grayed out and the main use of the Blackmagic system preferences is to tell you
which version of Desktop Video software is installed for video capture via a Thunderbolt port.

When other Blackmagic video capture hardware is connected to your computer, additional settings
may be available.

How to Update Your HyperDeck Software on Mac OS X
Step 1.  Download and unzip the HyperDeck Utility software.

Step 2. Open the resulting disk image and launch the HyperDeck Installer. Follow the onscreen
instructions.

Step 3.  Afterinstalling the latest Blackmagic HyperDeck Utility, connect a USB cable from HyperDeck
to your computer.

Step 4. Launch Blackmagic HyperDeck Utility and follow any onscreen prompt to update the internal
software in your HyperDeck. If no prompt appears, the internal software is up to date and
there is nothing further you need to do.

How to Update Your HyperDeck Software on Windows
Step 1. Download and unzip the HyperDeck Utility software.

Step 2.  You should see a HyperDeck Utility folder containing this manual and the HyperDeck Utility
installer. Double-click the installer and follow the onscreen prompts to complete the installation.

Step 3.  Afterinstalling the latest Blackmagic HyperDeck Utility, connect a USB cable from HyperDeck
to your computer.

Step 4. Launch Blackmagic HyperDeck Utility and follow any onscreen prompt to update the internal
software in your HyperDeck. If no prompt appears, the internal software is up to date and
there is nothing further you need to do.
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Selecting Your Video Format in HyperDeck Utility

All current HyperDeck models let you select from a choice of uncompressed and compressed video
formats. The original HyperDeck Shuttle exclusively records uncompressed video.

HyperDeck can record 10-bit uncompressed QuickTime files on a fast SSD, or to a compressed format
if you have a slower SSD or want to fit longer high definition recordings on a single SSD. This means
if you have used the HyperDeck Utility software to change the recording format, it is possible to have
uncompressed QuickTime files as well as compressed files on the same disk.

Working with uncompressed video is exciting as there is simply no better quality. However, if compressed
video better suits your workflow, or if you need to fit more video on a SSD, you can choose a high quality
professional compressed video format which is also perfect for editing.

HyperDeck Studio Pro records Ultra HD 4K video using Apple ProRes codecs, which are high quality
compressed codecs designed for post production.

To choose a video format:

Step 1.  Connect HyperDeck to your computer via USB.
Step 2.  Launch HyperDeck Utility. Your HyperDeck model will be named in the title bar of the utility.
Step 3.  Set the recording format from the dropdown menu and save the setting.

All subsequent clips will be recorded in the chosen format.

Setting the recording format also sets the playback format. For example, if you want to play back an
uncompressed 10-bit QuickTime file, set the recording format to Uncompressed 10 Bit QuickTime.
Setting Avid DNxHD as the recording format lets you play DNxHD QuickTime and MXF clips, and by
selecting Apple ProRes you can play clips using any of the ProRes codecs.

ProRes codecs include:

ProRes 422 (HQ) - For the highest quality compression at the maximum ProRes data rate.
ProRes 422 - For extremely high quality compression using a low ProRes data rate.
ProRes 422 LT - For high quality compression at a lower ProRes data rate.

ProRes 422 (Proxy) - For high quality offline compression at the lowest ProRes data rate.

ProRes clips will play back using the compression quality they were recorded in.
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HD (1920x1080)

Ultra HD 4K (3840x2160)

Ultra HD 4K is 4 times the resolution of HD.

Video In 4K SDI Out

« Single 6G-SDI

4K SDI Out
Dual 3G-SDI

Quad HD-SDI

+ Single 6G-SDI
Dual 3G-SDI
Quad HD-SDI

Choose between single link 6G-SDI, dual link 3G-SDI or
quad link HD-SDI for Ultra HD 4K playback.

About Ultra HD 4K

With four times as many pixels as full HD 1080p, Ultra HD 4K is the new standard for high resolution
video. This means you get 3840 x 2160 pixel resolution, allowing you the greatest creative control for
pixel perfect compositing, VFX work, color grading as well as the ability to project onto large displays
for digital signage and cinema projections.

HyperDeck Studio Pro features 6G-SDI technology, which is easily fast enough to handle Ultra HD 4K
playback to the latest 4K monitors. Previously you would have required 4 separate cables to get Ultra
HD resolution over SDI, but now with the amazing data rate 6G-SDI offers, you can get Ultra HD 4K
video over a single cable!

Setting Up Ultra HD 4K Recording

HyperDeck Studio Pro records Ultra HD 4K straight to the Apple ProRes codec. ProRes is the most user
friendly codec because it is QuickTime based, so your Ultra HD 4K footage can be imported to any
QuickTime compatible software. See the previous page for a description of each available ProRes codec.

Step 1.  Connect your Ultra HD 4K source to SDI or HDMI inputs. The SDI inputs will automatically
detect if you are connecting via single link 6G-SDI, dual link 3G-SDI or quad link HD-SDI.

Step 2.  Press the DISP button on the front of HyperDeck Studio Pro. Use the jog/shuttle wheel to
select Record then press the SET button. Use the jog/shuttle wheel to select the desired
Codec, then press the SET button to confirm.

Step 2.  Press the INPUT button once while the stop button is illuminated. The Input button will
illuminate and you will be able to preview the video source on the LCD before recording.

Step 3.  Press the record button to start recording your Ultra HD 4K source.

Setting Up Ultra HD 4K Playback

You can set the output through which HyperDeck Studio Pro will playback Ultra HD 4K with the Display
menu on the LCD:

Step 1.  Press the DISP button on the front of HyperDeck Studio Pro.
Step 2.  Press the SET button to enter the Video menu.

Step 3.  Usethejog/shuttle wheel to select 4K SDI Out. Press SET to enter the menu and scroll between
Single 6G-SDI, Dual 3G-SDI or Quad HD-SDI. Press SET to confirm your selection.

Step 4.  Press the DISP button to exit back to your video feed.
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ProRes

Accessing Your Clips

To access your clips, simply connect the SSD to your computer using an SSD dock. You can either drag
the files from the SSD directly to a local hard drive, or you can work directly from the SSD. You can also
connect the SSD to your computer with a 2.5" eSATA to USB cable adapter, however this won't be fast
enough to handle working directly from the SSD and is really only recommended as a portable solution
for getting your video files off the SSD and onto a laptop.

Mac OS X

QuickTime is built into Mac OS X. Apple ProRes and uncompressed QuickTime movies recorded by
HyperDeck can be opened in almost any video software on Mac OS X.

DNxHD MXF files recorded by HyperDeck can be opened with Avid Media Composer and DaVinci
Resolve for Mac.

MCC closed caption data files recorded by HyperDeck can be opened with MacCaption software for
Mac OS X from http://www.cpcweb.com.

Windows

Apple ProRes and uncompressed QuickTime movies recorded by HyperDeck require QuickTime
to be installed on your PC. Almost any video software on Windows that supports QuickTime can
open movies recorded by HyperDeck. QuickTime for Windows can be downloaded free from
http://www.apple.com/quicktime/download/.

DNxHD MXF files recorded by HyperDeck can be opened with Avid Media Composer and DaVinci
Resolve for Windows.

MCC closed caption data files recorded by HyperDeck can be opened with CaptionMaker software for
Windows from http://www.cpcweb.com.

Status Indicators

When recording or playing video with HyperDeck, any information you need to know is displayed on
the unititself. HyperDeck Shuttle's backlit buttons and LEDs provide vital information such as when your
disk is nearly full and the remaining battery life, whereas HyperDeck Studio models display information
ona LCD.
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Status indicators on HyperDeck Shuttle tell you whether your
SSD is formatted correctly, whether a video signal is detected
and how much battery power is left.
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The SSD slots on HyperDeck Studio models indicate if an SSD
is formatted correctly and whether the unit is in recording or
playback mode. The LCD on HyperDeck Studio models shows
your video as well as status information.
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You can use the DISP menu on HyperDeck Studio models

to select between recording in uncompressed, ProRes or
DNxHD. HyperDeck Studio Pro includes four ProRes codecs.
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HyperDeck Shuttle

SSD Indicator

When you first switch on HyperDeck Shuttle, or any time you insert an SSD, the SSD indicator will light
up while checking the SSD and then switch off. If the SSD has not been formatted correctly, or fails to
work, the SSD indicator will illuminate solid red until the SSD is removed. Check if the SSD is formatted
correctly and also check that it works with a computer.

Video Indicator
The VIDEO indicator lights up when a video signal is detected by HyperDeck Shuttle.

Battery Indicator

The four green battery indicators display the internal battery charge level. When all the LEDs go off,
there's approximately 4 minutes of battery power left. So you should plug in your external power source
or switch to another charged HyperDeck Shuttle.

HyperDeck Studio Models

SSD Slot

When you first power on HyperDeck, or any time you insert an SSD, the SSD slot will light up while
checking the SSD and then switch off. If the SSD has not been formatted correctly, or fails to work, the
SSD slot will illuminate solid red until the SSD is removed. Check if the SSD is formatted correctly and
also check that it works with a computer.

LCD

HyperDeck Studio models feature an LCD that not only shows your video but also displays status
information such as video format and frame rate, record, playback and jog modes, the active SSD slot
as well as timecode and audio levels.

Using the Display Menu on HyperDeck Studio Models

On HyperDeck Studio models you can use the Display menu to change your video and audio inputs
and outputs as well as any settings changes you would make in the HyperDeck Utility such as trigger
recording, timecode source and your chosen recording codec.

Step 1.  Press the DISP button to bring up the main menu.

Step 2.  Use the jog/shuttle wheel on the front of HyperDeck to highlight different options.

Step 3.  Pressthe SET button to confirm a selection.

Step 4. Toreturn to a previous menu, scroll to the return arrow and press SET.

Step 5.  Press the DISP button to exit.
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8 00 HyperDeck Studio Pro

Set recording format to: ( Uncompressed 10 Bit QuickTime } 3]

| Playback media timecode track to output

Trigger recording: () Never

(_) When SDI start/stop is detected
(*) When timecode runs

Save

Use the HyperDeck Utility to enable Start/Stop Recording.
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You can use the DISP menu on HyperDeck Studio models to
select the different options for trigger recording.

Selecting Timecode Source

When recording from HD-SDI video sources that provide embedded SMPTE RP 188 metadata,
you can record the embedded timecode from the video source instead of using timecode generated
by your HyperDeck.

To set this on HyperDeck Studio models using the Display menu:

Step 1.  Press the DISP button to bring up the main menu.

Step 2.  Scroll to the Timecode menu and press SET.

Step 3.  Press SET to enter the Timecode Source menu and select Input.
Step 4.  Press SET to confirm your selection.

It might be necessary to turn on the RP 188 setting in your camera before HyperDeck will be able to
record the timecode.

SDI Start/Stop Recording

HyperDeck supports start/stop recording, which means when you press the record button on an HD-
SDI camera, HyperDeck will start recording without also having to press the record button on your
HyperDeck disk recorder.

To set up start/stop recording for supported cameras:

Step 1.  Youwill need a camera that can trigger the record function of HyperDeck via HD-SDI. Cameras
which support trigger recording via HD-SDI may include menu options such as "Trigger REC",
"HD-SDI Remote I/F" or "SDI Remote Start/Stop Trigger".

Step 2.  In HyperDeck Utility, set Trigger recording to "When SDI start/stop is detected".

Step 3.  Ifusing HyperDeck Studio models, press the REM button after setting SDI start/stop recording
in HyperDeck Utility. The REM button must be illuminated on the unit to allow trigger recording.

To set this on HyperDeck Studio models using the Display menu:

Step 1.  Press the DISP button to bring up the main menu.

Step 2.  Scroll to the Record menu and press SET.

Step 3.  Scroll to the Record Trigger menu and press SET.

Step 4. Select SDI Start/Stop and press SET to confirm your selection. Press DISP to exit.

Step 5.  Pressthe REM button. The REM button must be illuminated on the unit to allow trigger recording.



k4 Using HyperDeck

8 0n HyperDeck Studio Pro

Set recording format to: [ Uncompressed 10 Bit QuickTime | :]

|| Playback media timecode track to output

Trigger recording: () Never

() When SDI start/stop is detected

(*) When timecode runs

Save

Use the HyperDeck Utility to enable Timecode Run recording.

Codec Record Trigger

None

SDI Start/Stop
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Use the DISP menu on HyperDeck Studio models to set
Timecode Run recording.
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The fast forward button on the front of HyperDeck Studio
models lights up when fast forwarding through clips.

Timecode Run Recording

HyperDeck also supports timecode run recording, which is similar to start/stop recording, but is only
used if your HD-SDI camera does not support trigger recording via HD-SDI.

To set up timecode run recording:

Step 1.  Go into your camera's timecode settings and change them from "free run timecode" to
"record run timecode".

Step 2.  In HyperDeck Utility, set Trigger recording to "When SDI timecode runs".

Step 3.  If using HyperDeck Studio, press the REM button after setting Timecode Run Recording in
HyperDeck Utility. The REM button must be illuminated on the unit to allow trigger recording.

To set this on HyperDeck Studio models using the Display menu:

Step 1.  Press the DISP button to bring up the main menu.

Step 2.  Scroll to the Record menu and press SET.

Step 3.  Scroll to the Record Trigger menu and press SET.

Step 4. Select Timecode Run and press SET to confirm your selection. Press DISP to exit.

Step 5.  Pressthe REM button. The REM button must be illuminated on the unit to allow trigger recording.

Now whenever your HyperDeck detects the timecode running via HD-SDI it will start recording. Recording
will stop whenever the timecode stops.

Be careful if your HyperDeck is connected to the SDI output of a video router, as any change to the
video source might cause HyperDeck to start recording unexpectedly due to a change in timecode
being detected via HD-SDI.

Shuttling with HyperDeck Shuttle

During playback, press and hold the Previous Clip or Next Clip button to rewind or fast forward at 2x
speed. Press the Previous Clip or Next Clip button again and the speed will increase to 4x and then 8x.
Once you've found the section you want to review, press Play and playback will resume at normal speed.

Jog and Shuttle with HyperDeck Studio Models

During playback, press the reverse or fast forward button to play through the clip at 2x speed. Press the
reverse or fast forward button again and the speed will increase to 4x and then 8x. Once you've found
the section you want to review, press play to resume normal playback.
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You can also use the Jog/Shuttle Wheel to shuttle to a particular section at variable speeds. The more
you turn it forwards or backwards, the faster your HyperDeck Studio will play through your video. Once
you've found the section you want to review, press play to resume normal playback.

If you want to slowly jog through your video frame by frame, press the JOG button once to enable
jog operation. Turning the jog/shuttle wheel in the desired direction will then jog through your video.
REFIN Pressing the JOG button again will return the wheel to shuttle operation.

RRRRR HyperDeck Studio and HyperDeck Studio Pro feature a Reference input, which accepts blackburst and

ﬁ tri-level sync signals from a sync generator. Connect a reference source to this input if you want to

o synchronize HyperDeck with other video equipment, such as a production switcher.

Ref Input

Reference input on HyperDeck Studio.

RS-422 Control

What is RS-422 Control?

1
?
l The RS-422 standard is commonly supported by NLE hardware and software and allows video players
and recorders to be remotely controlled by an external RS-422 controller or capture device. You can
remotely control HyperDeck Studio models using your favorite NLE software and video capture hardware
to remotely capture, batch capture and play back video with your HyperDeck Studio. All you need to do
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7876 is connect an RS-422 cable from your capture device to HyperDeck Studio and press the REM button
to enable remote deck control.
Receive Receive Transmit Transmit Ground
e * e * Pins Using an External RS-422 Controller
2 ’ k ’ 1467 Both HyperDeck Studio models feature an industry standard Sony™ compatible RS-422 deck control
RS-422 remote pin connections. port, which has the correct pin connections for a direct connection to any remote controller with RS-422.

You can use pre-manufactured 9 pin cables as long as each end of the cable is wired “pin for pin” where
the same pin numbers on each end of the cable are connected together. If you would like to make custom
cables, please refer to the accompanying wiring diagram.

REMOTE

You can remotely control your HyperDeck Studio from an RS-422 controller instead of locally pushing buttons.

Step 1.  Connect a video signal to an SDI or HDMI video input of your HyperDeck Studio.

:

Remote port on HyperDeck Studio. Step 3.  Press the REM button to enable remote deck control.

Step 2.

Connect an RS-422 cable from your external controller to your HyperDeck Studio.
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REMOTE
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Press the REM button on HyperDeck Studio models
to enable RS-422 deck control.
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For crash recording, set trigger recording to "When SDI
timecode runs" in the DISP menu.

You can now remotely start and stop recording and playback of your HyperDeck Studio as well as
performing other common jog and shuttle functions. The full list of supported RS-422 commands is in
the following section named "Supported RS-422 Commands".

Daisy-chaining for Crash Recording

You can simultaneously record the same SDI video signal to multiple HyperDeck Studios. Press the REM
button on each HyperDeck Studio to enable remote deck control. Each HyperDeck Studio can be set
to record in a compressed or uncompressed video format using HyperDeck Utility.

Step 1.
Step 2.

Step 3.

Step 4.

Step 5.

Connect a video signal to the SDI video input of the first HyperDeck Studio in the chain.

If you are working entirely in high definition, connect a single channel RS-422 controller to
the first HyperDeck Studio in the chain. RP188 timecode will be sent over SDI to every other
HyperDeck in the chain. If working with standard definition video, you will need a multiple
channel RS-422 controller connected to each HyperDeck Studio in your chain via RS-422.

Connect an SDI cable from the SDI Loop output on the first HyperDeck Studio to the second
HyperDeck Studio's SDI input. Repeat this for however many HyperDeck Studios you want
to daisy-chain together.

On the first HyperDeck Studio, press the DISP button. Scroll down to Record and press
SET. In the record menu, scroll to Record Trigger and press SET. Scroll to Timecode Run
and press SET.

Press the DISP button to exit the record menu. All connected HyperDeck Studios will record
the same video signal simultaneously.

You can now use your external RS-422 controller to set multiple HyperDeck Studios to remotely crash
record the same video signal.
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Supported RS-422 Commands

Command Reply No Remote Notes
0 - System Control
NTSC: OxFOEO
0x00 0x11 DeviceTypeRequest PAL: OXF1EO Enabled
24P: OxF2EO
1 - Slave Response

0x20 0x00 Stop Acknowledge Disabled
0x20 0x01 Play Acknowledge Disabled
0x20 0x02 Record Acknowledge Disabled
0x20 0x10 FastFwd Acknowledge Disabled
0x21 0x11 JogFwd1 Acknowledge Disabled

. Treated as N=1;
0x22 0x11 JogFwd?2 Acknowledge Disabled Same as JogFwd1
0x21 0x12 VarFwd1 Acknowledge Disabled Uses ShuttleFwd1

. Treated as N=1;
0x22 0x12 VarFwd2 Acknowledge Disabled Same as VarFwd1
0x21 0x13 ShuttleFwd1 Acknowledge Disabled

. Treated as N=1;
0x22 0x13 ShuttleFwd2 Acknowledge Disabled Same as ShuttleFwd1
0x20 0x20 Rewind Acknowledge Disabled
0x21 0x21 JogRev1 Acknowledge Disabled
0x22 0x21 JogRev2 Acknowledge Disabled Treated as N=T;

Same as JogRev1
0x21 0x22 VarRev1 Acknowledge Disabled Uses ShuttleRev1
0x22 0x22 VarRev2 Acknowledge Disabled Treated as N=1;
Same as VarRev1

0x21 0x23 ShuttleRev1 Acknowledge Disabled

. Treated as N=1;
0x22 0x23 ShuttleRev2 Acknowledge Disabled Same as ShuttleRev
0x20 0x30 Preroll Acknowledge Disabled
Ox24 0x31 CueData Acknowledge Disabled
0x20 0x34 SyncPlay Acknowledge Disabled
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Supported RS-422 Commands

Command Reply No Remote Notes

0x21 0x38 ProgSpeedPlayPlus Acknowledge Disabled

0x21 0x39 ProgSpeedPlayMinus Acknowledge Disabled

0x20 0x40 Preview Acknowledge Disabled Status bits are set
0x20 0x41 Review Acknowledge Disabled Status bits are set
0x20 0x43 OutpointPreview Acknowledge Disabled

0x22 0x5C DMCSetFwd Acknowledge Disabled

0x22 0x5D DMCSetRev Acknowledge Disabled

0x20 0x60 FullEEOff Acknowledge Disabled

0x20 0x61 FullEEOn Acknowledge Disabled

0x20 0x63 SelectEEON Acknowledge Disabled

0x40 0x10 InEntry Acknowledge Disabled

0x22 0x23 ShuttleRev2 Acknowledge Disabled Sa-rl;:zaz::(;sjtt,\lle?e;ﬂ
0x20 0x30 Preroll Acknowledge Disabled

0x24 0x31 CueData Acknowledge Disabled

0x20 0x34 SyncPlay Acknowledge Disabled

0x21 0x38 ProgSpeedPlayPlus Acknowledge Disabled

0x21 0x39 ProgSpeedPlayMinus Acknowledge Disabled

0x40 0x11 OutEntry Acknowledge Disabled

Ox44 0x14 InDataPreset Acknowledge Disabled

Ox44 0x15 OutDataPreset Acknowledge Disabled

0x40 0x18 InFwd Acknowledge Disabled

0x40 0x19 InRev Acknowledge Disabled

0x40 Ox1A OutFwd Acknowledge Disabled

0x40 0x1B OutRev Acknowledge Disabled

0x40 0x20 InReset Acknowledge Disabled

0x40 0x21 OutReset Acknowledge Disabled

0x40 0x22 AlnReset Acknowledge Disabled
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Supported RS-422 Commands

Command Reply No Remote Notes
0x40 0x23 AQutReset Acknowledge Disabled
Ox44 0x31 PrerollPreset Acknowledge Disabled
0x40 0x40 AutoModeOff Acknowledge Disabled ignored, Status bit
remembered
0x40 0x41 AutoModeOn Acknowledge Disabled ignored, Status bit

remembered

6 - Sense Request

0x61 Ox0A TimeCodeGenSense
Request for Gen TC GenTCData Enabled
Timer1Sense Timer1Data Enabled
UserBitsVITCTimeSense UserBitsVITCTimeData Enabled
LTCUserBitsTimeSense LTCUserBitsTimeData Enabled
VITCUserBitsTimeSense VITCUserBitsTimeData Enabled
0x60 0x10 InDataSense InData Enabled
0x60 0x11 OutDataSense OutData Enabled
0x60 0x12 AlnDataSense AlnData Enabled
0x60 0x13 AQutDataSense AOQutData Enabled
0x61 0x20 StatusSense StatusData Enabled
0x40 Ox2E SpeedSense SpeedData Enabled
0x60 0x31 PrerollTimeSense PreRollTimeData Enabled
0x60 0x36 TimerModeSense TimerModeData Enabled
0x60 Ox3E RecordInhibitSense RecordInhibitStatus Enabled
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Supported RS-422 Commands

Command Reply No Remote Notes
0x78 0x00 Timer1Data - - Curtent Time and
0x78 0x04 LTCUserBitsTimeData : . Curtent Time and
0x78 0x06 VITCUserBitsTimeData - - C“ggfgoggg;”d
Ox74 0x06 VITCTimeData - - Current Time
Ox74 0x07 UserBitsVITCTimeData - - 00:00:00:00
Ox74 0x08 GenTCData - - Current Time
0x78 0x08 GenTCUBData - . C“ggfgogggoa”d
Ox74 0x09 GenUBData - - 00:00:00:00
Ox74 0x10 InData - -
Ox74 Ox11 OutData - -
Ox74 0x12 AlnData - -
Ox74 0x13 AOutData - -
Ox74 Ox14 CorrectedLTCTimeData - - Current Time
Please see “Status Bits”
0x70 0x20 StatusData - - sheet: Limited to 9 bytes
of status, silently truncated
0x71 Ox2E SpeedData - -
Ox74 0x31 PrerollTimeData - -
0x71 0x36 TimerModeData - - Returns O (TimeCode)
0x72 Ox3E RecordInhibitStatus - -
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RS-422 Developer Information

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O
Byte O 0 0 Cassette out 0 0 0 0 Local
Byte Standby 0 Stop 0 Rewind Forward Record Play
Byte Servo Lock 0 Shuttle Jog Var Direction Still 1
Byte Auto Mode 0 0 0 Aout Set Ain Set Out Set In Set
Byte 4 Select EE Full EE 0 0 0 0 0 0
Byte 0 0 0 0 0 0 0 0
Byte 6 0 Lamp Still Lamp Fwd Lamp Rev 0 0 0 0
Byte 0 0 0 0 0 0 0 0
Byte 8 0 0 Near EOT EOT 0 0 0 0
Byte 9 0 0 0 0 0 0 0 0

Variables

Cassette Out

Local

Standby

Direction

Still

Auto Mode

Select EE, Full EE
Lamp Still/Fwd/Rev
Near EOT

EOT

Others

Cue Complete (byte 2, bit 0)

Set if no SSD is present

Set if Remote is disabled (local control)

Set if a disk is available

Clear if playback is forwarding, set if playback is reversing

Set if playback is paused, or if in input preview mode

Set if in Auto Mode

Set if in input preview mode

Set according to playback speed and direction

Set if total space left on available SSDs is less than 3 minutes

Set if total space left on available SSDs is less than 30 seconds

Always 1: Cue requests are always instantaneous

HyperDeck Serial RS-422 Protocol

Protocol

Based on Sony 9-pin protocol

Interface

Baud rate

38.4 kBits/s

1 start bit

8 data bits

1 stop bit

1 parity bit

Odd parity




Using HyperDeck

The contents of the box includes:

x1
HyperDeck Shuttle
Mounting Plate

Socket Head Screws
M3 x 10mm

You will need:

x1

Hex Allen Key 2.5mm
(not included)
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Step 1

Step 2

/ e e— —FEF o

Installing the HyperDeck Shuttle Mounting Plate

HyperDeck Shuttle Mounting Plate is an optional accessory that lets you secure your HyperDeck Shuttle
to a camera rig with your choice of rail mounts, cold shoe mounts, articulated arms and more. You can
also use the plate to power your HyperDeck Shuttle from an external battery by attaching a V-Mount
or Anton Bauer style battery plate. HyperDeck Shuttle Mounting Plate is available for purchase from
Blackmagic Design resellers. For easy installation, please follow these simple steps.

Step 1. Peel back the rubber mat from all four corners of the base so you can just see the screws.
Remove all four screws.

Step 2. Remove the base.

Step 3.  Attach your HyperDeck Shuttle Mounting Plate using the supplied socket head screws.
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Capturing video via Thunderbolt

When connected to a computer with Thunderbolt technology, HyperDeck Studio Pro can be used as a
powerful capture solution for your editing workflow. Thunderbolt offers a blazingly fast 10 Gb/s connection,
which is enough bandwidth to handle the highest resolution video formats easily!

Capturing from SSD

If you want to dub a video that you've already recorded to SSD, you can capture via Thunderbolt using
the video software and codec of your choice.

Step 1.  Connect HyperDeck Studio Pro via a Thunderbolt cable to your computer.

Step 2.  Launch your video capture software, such as Media Express, Adobe Premiere Pro, Apple
Final Cut Pro 7or AVID Media Composer.

Step 3. Make sure your software is configured to capture the same format as your source.
e.g., 1080i/50, 720p/60.

Step 4.  Press Play on HyperDeck Studio Pro. Video should appear on your computer screen within
a few seconds.

Step 5.  Click the capture button in your video software.

Simultaneous Capture and Recording

You can also simultaneously capture via Thunderbolt while recording to a SSD. This might be useful
if you are recording a live event and are unsure if you have enough space on your SSDs to record
the whole event. Alternatively, you may want to record in two different codecs, such as ProRes and
DNxHD, simultaneously.

Step 1.  Connect HyperDeck Studio Pro via a Thunderbolt cable to your computer.

Step 2.  Launch your video capture software, such as Media Express, Adobe Premiere Pro, Apple
Final Cut Pro 7 or AVID Media Composer.

Step 3. Make sure your software is configured to capture the same format as your source.
e.g., 1080i/50, 720p/60.

Step 4.  Pressthe INPUT button on HyperDeck Studio Pro to select the input from which you want to
record to SSD and capture to your computer.

Step 5.  Press Record on HyperDeck Studio Pro and click the capture button in your video software.
You are now recording the same video input to both the SSD and to your computer.
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Media ComposefifSoftware

: reserved.
toa ted license agreement. Computer Name: blackmagic's imac

Media Composer

Step 5. Type a project name and set the project options.

Avid Media Composer

Avid Media Composer captures standard and high definition video live from HyperDeck Studio Pro via
a Thunderbolt cable. When you install the HyperDeck Software, Blackmagic plug-ins are automatically
installed to Media Composer.

You can use the INPUT button on HyperDeck Studio Pro to select your video and audio connections
including SDI, HDMI and analog.

HyperDeck Utility also installs a HyperDeck Studio deck preset to help with RS-422 deck control.

Setting up

Step 1.  Launch Media Composer and the Select Project dialog box will appear.

Step 2.  Choose your preferred User Profile if you have previously created one.

Step 3.  Select the folder in which you want to create the project: Private, Shared or External.

Step 4. Click the New Project button.

Step 5. Type a project name and set the project options including Format and Color Space. Click OK.
Once the project has been created, the frame rate and raster cannot be changed. The color
space setting can be changed later in the Format tab of the project.

Step 6.  Double-click the project name in the Select Project dialog box. The Media Composer interface

will appear along with the project window for your new project. You have completed setting
up your project.
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Capturing live via Thunderbolt
To capture video live via Thunderbolt from HyperDeck Studio Pro:

Step 1.  Choose Tools > Capture to open the Capture Tool.

Step 2.  Set up the Capture Tool to capture video by clicking the Toggle Source button.

Step 3.  Set the Video and Audio input menus to "Blackmagic".

Step 4. Select the video source track (V) and the audio source tracks (A1, A2, ...) you wish to capture.
Step 5.  Use the Bin menu to select a Target Bin from the list of open bins.

Step 6.  From the Res (resolution) menu, choose which compressed or uncompressed codec you wish
to use for your captured clips. For maximum quality uncompressed video, choose "1:1" for
8-bit video capture or "1:1 10b" for 10 Bit video capture.

Step 7.  Select the disk storage for your captured video and audio. Use the Single/Dual Drive Mode
button to determine if video and audio will be stored together on a single drive or video on
one drive and audio on another drive. Select the target drive(s) for your captured media from
the Target Drives menu(s).

Step 8.  Click the "Tape Name?" button at the bottom of the window to open the Select Tape dialog
box. Select the desired tape, or add a new one, and then click OK.

Step 9.  Ensure your video and audio source is ready or playing and then click the Capture button or
press the F4 key. The Capture button will flash red while recording. Click the Capture button
again or press the Escape button on your keyboard to end the capture.

If you can't see an image in your video capture window:

Step 1.  Quit Media Composer.

Step 2. Set up the Capture Tool to capture video by clicking . ) o
the Toggle Source button. Step 2.  Launch Blackmagic UltraScope. Note the output video standard that is displayed on the left

side of Ultrascope's Picture Display. Quit UltraScope.

Step 3. Launch Media Composer and set the project preferences to match the standard reported
by UltraScope.
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¢ Apple Final Cut Pro 7

Final Cut Pro When you install the HyperDeck Software, Blackmagic Easy Setups are automatically installed to

Final Cut Pro 7.

Ucensea T Setting up
Step 1.  Launch Final Cut Pro 7 and the Easy Setup window will appear.
Step 2.  Click onthe popup menu and select the desired Blackmagic Easy Setup. For each video format

(NTSC, PAL and HDTV) you will find a range of Blackmagic compressed and uncompressed
file formats you can choose.

Final Cut Pro 7 Step 3.  Click on the popup menu named Primary Scratch Disk and select your disk array from the
popup menu.

Step 4. Click OK and the Final Cut Pro interface will appear.

Format: [ NTSC ) Rate: i raes) [8) Capturing live via Thunderbolt
Use: | Blackmagic NTSC - 10 bit 4]

To capture video live via Thunderbolt from HyperDeck Studio Pro:

Use this setting when editing with NT5C in 10 Bit

Seguerce preset. Backmac TSC 10 b Step 1. Select a Blackmagic Easy Setup. Final Cut Pro will sometimes warn that device control has
layback Ourput videor Backmagic NTSC - 10 i (720 x 486) been setto “non-controllable device”. This is as expected. Click OK and then create a project
Playback Output Audio: DeckLink Audio

Edit to Tape/PTV Dutput Video: Same as Playback

Edit to Tape, PTV Output Audio: Same as Playback Wlth these settings.

Step 2. Choose File > Log & Capture. (Command + 8).

Step 3.  Press play on HyperDeck Studio Pro and then press the Now button in the Log and Capture

Primary Scratch Disk: [ RAID ) ok ) window. Final Cut Pro will show you a preview of the video you are capturing.
Select a Blackmagic Easy Setup Step 4.  Press esc to stop capturing.

If you can't see an image in your video capture window:
Step 1.  Quit Final Cut Pro.

Step 2.  Launch Blackmagic UltraScope. Note the output video standard that is displayed on the left
side of Ultrascope's Picture Display. Quit UltraScope.

Step 3. Launch Final Cut Pro and set the project preferences to match the standard reported
by UltraScope.
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Premiere Pro CC (2014)

Adobe® Premiere Pro® CC

When you install the HyperDeck Software, Blackmagic plug-ins are automatically installed to
Adobe Premiere Pro CC.

Setting up a Blackmagic Design project

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Step 6.

Step 7.

Step 8.

Launch Premiere Pro.

Create a New Project and click on the Scratch Disks tab.

Set the desired Location and Name for your project at the bottom of this window.

Set the locations for your captured video, captured audio, video previews and audio previews.

If your graphics card is supported by Premiere Pro CC's Mercury Playback Engine, the
Renderer option will be available and you should switch it to Mercury Playback Engine GPU
Acceleration.

Set the Capture Format to Blackmagic Capture and click on the Settings button to reveal the
Blackmagic Capture Settings for your project. Set your desired Video Standard and Video Format.

Select File > New Sequence to open the New Sequence window. To preserve maximum video
quality, you can create a full resolution uncompressed sequence. To do so, click the discovery
triangle next to "Blackmagic Design”, select a preset to match the video standard and choose
from uncompressed 8 bit YUV, 10 bit YUV or 10 bit RGB. If you don't have the storage space or
disk speed for uncompressed video, choose a sequence preset that your computer system will be
able to handle.

When you have selected the desired sequence preset, give the sequence a name and click OK.
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Capture

Photoshop CC (2014)

Capturing live via Thunderbolt
To capture video live via Thunderbolt from HyperDeck Studio Pro:

Step 1. Choose: File > Capture [F5]

Step 2. Press play on HyperDeck Studio Pro and then Click the red record button [G]. A preview of the
video you are capturing will appear.

To change the capture format, click on the Settings tab and then the Edit button. Ensure the Capture Format
is set to Blackmagic Capture, click on the Settings button and then change the Blackmagic Capture Settings
as desired.

If you can't see an image in your video capture window:
Step 1. Quit Premiere Pro.

Step 2. Launch Blackmagic UltraScope. Note the output video standard that is displayed on the left side
of Ultrascope's Picture Display. Quit UltraScope.

Step 3. Launch Premiere Pro and set the project preferences to match the standard reported by
UltraScope.

Adobe® Photoshop® CC

How to grab video frames
Step 1. From Photoshop select File > Import > Blackmagic Image Capture.
Step 2. Select the "Video Input Format” and the “Image Bit Depth” and then click Import Image.

Once you have set the options in the Import window, each subsequent import will not display the window,
so you can grab frames much faster. However if you would like to change your import format, hold the
Option key when selecting import.

8 00 Blackmagic Image Import

Image Import Settings

Video Input Format: | YUV 4:2:2 HD 1080i 59.94 2
Image Bit Depth: | Photoshop RGB 16 Bits/Channel il
| Cancel | [ Import Image ]

Image Capture
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Mark

View

v HyperDeck Studio Pro
Intensity Extreme

Select your HyperDeck Studio Pro from the Device menu.

Project Video Format:

Capture File Formar:

When capturing DPX files, use

Preferences

HD 10801 50

QuickTime Uncompressed 10=bit YUV

Use dropped frame timecode
v Capture to DPX from a YUV source
Use absolute frame numbering when capturing DPX

8 : digit numbers in the frame count

Capture audio and video to:

Capture still frames to:

/Volumes/Media

Browse For all video and audio media file captures

| Volumes/Media ]

Browse For all still frame captures only

(¥ stop capture if dropped frames are detected
gSlup playback if dropped frames are detected
| Use Anamorphic 5D 16:9

chnt‘mue playback when in the background

Set deck to
When capturing use a

When mastering use a

5 +| second pre-roll for cueing
0 3| frame timecode offset

0 #| frame timecode offset

Media Express Preferences

Capturing Video and Audio Files

Blackmagic Media Express 3 software is included with every HyperDeck Studio Pro to perform video and
audio capture to files. Blackmagic Media Express 3 is a great tool when you don’t need the complexity
of NLE software, but simply want to capture video from HyperDeck Studio Pro's Thunderbolt port.

Selecting HyperDeck Studio Pro

If you have more than one Blackmagic Design capture product installed or connected to your computer,
go to the Device menu in Media Express and select HyperDeck Studio Pro. In the example pictured on
this page, an Intensity Extreme and a HyperDeck Studio Pro are both connected to the same computer.
Selecting your HyperDeck Studio Pro will allow you to choose suitable video settings for your project.

Setting Up a Project

Before capturing any clips in Media Express, you will need to select the settings for your project.

Step 1.  Go to Media Express>Preferences. Any settings which are grayed out are only used with
other Blackmagic Design capture products and are not required by HyperDeck Studio Pro.

Step 2.  Set the project video format (i.e., HD1080p) and also set the frame rate.

Step 3.  Select from a range of professional compressed and uncompressed capture file formats
or even a DPX image sequence in the Capture File Format drop down menu. Video will be
captured in the chosen format and saved to a QuickTime movie.

Step 4. Set the storage location for your captured video and audio.

Step 5. Choose whether to stop capture or playback if dropped frames are detected.

Usually video applications stop playing video if you send them to the background. If you want Media
Express to keep playing video, even if you open another application in the foreground, enable the
checkbox to "Continue playback when in the background".

The final options for pre-roll and frame timecode offset are not used by HyperDeck Studio Pro when
capturing video via a Thunderbolt connection. They relate to tape decks with RS-422 deck control.
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Media List Timecode List, Thumbnail and Favorites view Search Field

1080p 23 ProRes 2cl ZOIC 2008 Craftamai  20IC 2008 Sea Work ZOIC 2008 Sprite 10{ ZOIC 2008 TV 1080p Z0IC 2010 1080p 23

¥ Todays rushes 12 Clips

ZOIC 2010 1080p 23  ZOIC 2010 1080p 23  ZOIC 20101080p 23 ZOIC 2010 1080p23  ZOIC 2010 1080p 23  ZOIC 2010 1080p 23

Ml

Z0IC 2010 1080p 23  ZOIC 2011 1080p23 § ZOIC 2010 1080p 23 1080p 23 ProRes 2c!  ZOIC 2011 1080p23 § ZOIC 2008 Sprite 10f

¥ VFX plates

Log and Capture

ZOIC 2008 Sea Work ZOIC 2008 TV 1080p Z0IC 20101080p23 ZOIC 2010 1080p23  ZOIC 2010 1080p 23  ZOIC 2010 1080p 23 In: out:
' » 00:00:00:00 00:00:00:00

Name:

Daseription:
Z0IC 2010 1080p 23  ZOIC 2010 1080p 23

¥ New shots from lecation 2 5 Clips.

Capture

Project name, video format Clip Bins Mark In / Mark Grab Still Logging
and frame rate Out Frame Information

4

Batch

Capture
options

VTR / deck timecode

Transport
Controls

Audio channel
enable/disable

Video Preview

w.

8

Audio Meters

9

ZOIC.

10 11 12113 14 15 16

Remote
indicator
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T Capture

Capturing video is easy. All you need to do is connect HyperDeck Studio Pro via a Thunderbolt cable,
e ; one set the Media Express preferences and press the Capture button.

» 00:00:00:00

Step 1.  Connect your video source to an input on HyperDeck Studio Pro.

Step 2.  Check that HyperDeck Studio Pro is set to the input you have connected your source to.
e.g. SDI, HDMI or analog.

Angle: 01 Step 3. Open Media Express and set its preferences to the project video format and capture file
format. The project video format must be set correctly otherwise you will not see your video
in the preview pane.

(@ Capturg Batch

Enter a description for your video . _ . . _
i youryt Step 4. ClicktheredLogand Capture tab and enter a description for your video into the Description

field of the logging information area.

R ey s e P e Step 5. Click the "+" button next to the Description to add it to the automatic Name field. Click the

"+" button next to any of the other fields that you wish to add to the Name field.

Set the desired number of audio channels to be captured
* You can increment the value in each of these fields by clicking on the corresponding

clapper board icon. Alternatively you can type directly into any field to customize its
name and number.

Log and Capture

= = The text in the automatic Name field will be applied to the clip(s) which are about

0:00:00  00:00:00:00 00:00:00:00 to be captured.

= Click the "star" icon next to the Name field if you want to log the clip as a favorite.

* Click the "1" icon next to the Name field if you wish a clip name confirmation prompt to
appear before every capture. This will provide you with the chance to change the clip name.

Capturing to Disk

Step 6.  Set the desired number of audio channels to be captured.

Gopwre | Gilp Baten Step 7.  Click the “Capture” button to start recording. To end capture, click the “Capture” button
again to automatically keep the clip. Alternatively, press esc if you want to be prompted to
delete or save the clip. The captured clips will be added to the Media List.

Click the Capture button to commence recording
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Preferences

Project video Formar:

Capture File Format:

When capturing DPX files, use

HD 1080p 23.98

DPX 10-Bit RGR

Use absolute frame numbering when capturing DFX

8 + | digit numbers in the frame count

DPX capture preferences

DPX Capture

If you want to capture a DPX image sequence rather than a movie file, open the Media Express preferences
and set the Capture File Format to DPX 10 Bit RGB. You will need a fast disk array to cope with the
uncompressed, 10 Bit RGB format.

Step 1.  Connect your video source to an input on HyperDeck Studio Pro.

Step 2.  Check that HyperDeck Studio Pro is set to the input you have connected your source to.
e.g. SDI, HDMI or analog.

Step 3. Open Media Express and create a DPX project by setting the capture file format to DPX.
Step 4.  Enter your description and logging information.

Step 5. Click the “Capture” button to start recording. To end capture, click the “Capture” button
again to automatically keep the clip. Alternatively, press esc if you want to be prompted to
delete or save the clip. The captured clips will be added to the Media List.

When the capture has been completed, a single thumbnail will appear in the Media List representing the
entire frame sequence. The sequence of DPX frames will be stored in its own folder in your disk storage.
Audio will be stored in a .wav file in the same folder.

By default, DPX captures are assumed to be from YUV sources. If you need to capture from an RGB
source, disable the "Capture to DPX from a YUV source" option in the preferences menu, otherwise
your DPX files will show weird pink and green colors.

If you want the DPX frame numbers to be based on the timecode of the captured video, rather than just
starting from zero, enable the option to "Use absolute frame numbering when capturing DPX".

If you aren't performing long DPX captures, you may wish to reduce the number of zeroes in the frame
numbers by changing the option "When capturing DPX files, use (2-8) digit numbers in the frame count".
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Media List Timecode List, Thumbnail and Favorites view Search Field VTR / deck timecode Video Preview

1080p 23 ProRes 2cl ZOIC 2008 Craftamai  20IC 2008 Sea Work ZOIC 2008 Sprite 10{ ZOIC 2008 TV 1080p Z0IC 2010 1080p 23

¥ Todays rushes 12 Clips

ZOIC 2010 1080p 23  ZOIC 2010 1080p 23  ZOIC 20101080p 23 ZOIC 2010 1080p23  ZOIC 2010 1080p 23  ZOIC 2010 1080p 23

Ml

Z0IC 2010 1080p 23  ZOIC 2011 1080p23 § ZOIC 2010 1080p 23 1080p 23 ProRes 2c!  ZOIC 2011 1080p23 § ZOIC 2008 Sprite 10f

A 1
¥ VFX plates . = ¥ 3 . u.

ZOIC.

Playback

ZOIC 2008 Sea Work ZOIC 2008 TV 1080p Z0IC 20101080p23 ZOIC 2010 1080p23  ZOIC 2010 1080p 23  ZOIC 2010 1080p 23 In: out: Duration:
' . 00:00:00:00 00:00:00:00 !4

Name:

E L Deseription:
20IC 2010 1080p 23  ZOIC 2010 1080p 23 et
Scene:

¥ New shots from location 2 5 Clips Take:

Angle:

8 9 10 11 1213 14 15 16

Project name, video format Clip Bins Mark In / Mark Clip Grab Still Favorites Transport Audio channel Audio Meters Remote
and frame rate Out Information Frame Selection Controls enable/disable indicator



Media Express

The video format of the selected clip does not match the
project settings.

Don't Save

New #EN
Open... #E0
Open Recent >

Save #S
Save As... {385

Import [ 4

Grab Still Frame
Capture Now
Batch Capture

Media Files...
Final Cut Pro XML...

There are three ways to import clips into Media Express

Playback

You can use the transport controls to play, stop, jump to the
next or previous clip and loop playback of your clips.

gl Using Blackmagic Media Express

Playing back Video and Audio Files

Importing clips
You can play back your video and audio files after importing media into Media Express in any of
the following ways:

* Double-click an empty area of the Media List.
* Right-click an empty area of the Media List and select Import Clip from the contextual menu.
* Go to the File menu, select Import and then Media Files.

Select the video and audio clip(s) you wish to import from the Open Video Clip dialog box. The clips
will appear in the Scratch area of the Media List. If you have created your own bins in the Media List, you
can drag the clips into the desired bin.

If you want to import media directly to a bin, right-click within the desired bin and select Import Clip
from the contextual menu.

If the files being imported do not match the frame rate and size of existing clips in the Media List, you
will be prompted to create a new project and to save the current project.

Media Express also supports the import of multichannel audio-only files recorded at 48kHz in the
uncompressed WAVE (wav) and AIFF (.aif) formats.

Another way to import media is to use an XML file which has been exported from Final Cut Pro. Go to
the File menu, select Import and then Final Cut Pro XML. Open the desired XML and all the bins and
media from the Final Cut Pro project will appear in the Media List.

Playing back single and multiple clips
To play back a clip, double-click the clip in the Media List. Alternatively select the clip in the Media List
and press the space bar on your keyboard or the play button in the transport controls.

To play back multiple clips, select the clips in the Media List and then press the space bar on your
keyboard or the play button in the transport controls.
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In the Media List, choose to view your clips in Timecode List view
or Thumbnail view. Click the Favorites button to only show your
favorite clips. Type in the Search field to find your favorite clips.

¥ *Scratch”

Raill joumey_1_2012-04-24_1723_C0000
In: Out: Dur:
17:23:59:00 17:36:40:00 00:12:41:01
Info: 1080p 24, ProRes 422 HQ, 1820x1080
Desc: None
Take:
Angle:

Click the popup info icon on a thumbnail to view its info bubble.

Clips marked as favorites are easily identified by the yellow
star in their icon.

In the Log and Capture tab, click the "star" icon next to the
Name field if you want to log the clip as a favorite.

Express

Browsing Media

In the Media List, you can view your clips in Thumbnail view or Timecode List view by clicking on the
desired view button at the top-right of the Media List.

Thumbnail view

Thumbnails are the most intuitive way to display your clips. To get information for a clip, hover your mouse
over the clip's thumbnail and then click on the popup info icon which will appear at the bottom-right of
the thumbnail. Click the info bubble to hide it.

List view

You can view your clips in Timecode List view by clicking on the Timecode List button at the top-right
of the Media List. Use the horizontal scroll bar at the bottom of the Media List to view all the columns
of information for your clips including: in and out points, video format, audio channels, field dominance
and logging information.

Creating and using bins
To create a bin for your clips, right click an empty spot in the Media List and select "Create Bin". Type
in a name for the new bin.

You can move clips from the Scratch, or from one bin to another, by dragging the clip icons to the desired
bin. If you want a clip to appear in more than one bin, import the same clip again by right-clicking on
the bin and choosing "Import Clip".

By default, logged clips appear in the Scratch. If you want to log clips and have them appear in a new

bin, right-click the new bin and choose "Select As Log Bin".

Creating and using favorites

In the Log and Capture tab, click the "star" icon next to the Name field if you want to log a clip as a favorite.

In the Playback tab, clicking the "star" icon will make the clip a favorite if it is selected in the Media List.
Click the "star" icon again to deselect it as a favorite.

Clips marked as favorites will show a yellow star in their icon in Timecode List view and Thumbnail view.

Once you have marked clips as favorites, click on the gray Favorites star button at the top of the Media
list and it will turn yellow. All clips in your Media List will be hidden except for those marked as favorites.
This is similar to creating a playlist and makes it easy to only play back your favorite clips and even master
them to tape.
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H-HE

Click the Favorites button at the top of the Media List to only
show your favorite clips. Type in the Search field to find clips.

Deleting clips and bins

To delete clips, select the unwanted clips and press the forward delete button on your keyboard.
This will only delete the clips from the Media List and they will safely remain stored on your disk.

To delete bins, right-click within a bin and choose "Delete Bin". This action will delete the bin and any
clips it contains. This will only delete the clips from the Media List and they will safely remain stored on
your disk.

Searching the Media List

Clips can easily be found in a project by typing the name of your clips in the Search field at the top of
the Media List. When used in conjunction with the favorites feature, the search will be confined to your
favorite clips so you will see a shorter list of found clips.
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Blackmagic UltraScope

What is Blackmagic UltraScope?

With HyperDeck Studio Pro you get the incredible features of Blackmagic UltraScope, which you can
even use with compatible Mac OS X and Windows notebook computers with Thunderbolt technology!
Blackmagic UltraScope software is installed by the HyperDeck Studio Pro Installer.

Previously broadcast quality television and post production scopes were incredibly expensive custom
solutions that only let you see one scope at a time on a tiny screen! Some scopes look ugly and don't
really look good in front of your client. With Blackmagic UltraScope, you get 6 wonderful scopes that
let you see all aspects of your video signals!

Blackmagic UltraScope is perfect for quality control checks of the output of your HyperDeck Studio Pro,
no matter which video input you use. Simply connect a Thunderbolt cable from your HyperDeck Studio
Pro to a Thunderbolt enabled computer and away you go!

Installation Requirements
HyperDeck Studio Pro connects to both Mac OS X and Windows computers with Thunderbolt technology.
The Blackmagic UltraScope software interface requires a computer display with a minimum resolution

of 1280 x 800 pixels to view two scopes simultaneously. Blackmagic Design recommends viewing all
6 scopes simultaneously by using a computer display resolution of 1920 x 1200 or 1920 x 1080 pixels.

Please see the support pages at www.blackmagicdesign.com for a comprehensive list of the latest
minimum system requirements for Blackmagic UltraScope for Mac OS X and Windows.


http://www.blackmagicdesign.com

4 Using Blackmagic UltraScope

Blackmagic UltraScope Interface

1. Parade Display 2. Waveform Display 3. Vectorscope Display

Blackmagic UltraScope

HD 1080i 59.94 01:15:16:22

4. Histogram Display 6. Audio Metering Display 7. Picture Display

5. Error Logging
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Full Screen view

2-Up view

Understanding Blackmagic UltraScope Views

Blackmagic UltraScope has two different views available depending on your workflow needs and screen
resolution. You have the choice of viewing six displays in “Full Screen” view, or for more compact viewing,
choose any 2 displays in “2-up” view.

The display view can be selected from the View menu.

Choose Full Screen to enter “Full Screen” view. If this option is unchecked, “2-up” view will be displayed.
You can quickly switch between Full Screen view and 2-up view by using the hot key CMD-F on Mac OS X.

In “2-up” view, select the desired left and right scopes by opening the View menu or by right-clicking
anywhere in the UltraScope window. Make your selections from the Left View and Right View menu
options. If you attempt to choose the same scopes for both the Left View and Right View, the existing
scopes will swap sides.

Screen Resolution Requirements for Display Views
= Full Screen view: 1920 x 1200 pixels or 1920 x 1080 pixels. If your monitor doesn't support
these resolutions, then Full Screen view will not be available.
* 2-up view: minimum resolution of 1280 x 800 pixels.
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HD 1080

Zoom Function

Parade Display

01:15:16:22

Zoom Function

Blackmagic UltraScope allows you to zoom in on various displays for a more detailed analysis.
This helpful function will also pan and zoom the graticules for each display in high resolution.

The zoom function is available in the Parade, Waveform, Vectorscope and Picture displays.

To zoom in, simply click @, on the bottom right of each respective display. Now you will be able to
view the display in finer detail. Drag the mouse within the display area to pan around the zoomed display.
Clicking @ again, will return the display back to its normal view.

Parade Display
Parade Display is perfect for checking for illegal colors and checking levels.

Press the RGB button to display the full height of each color channel as red, green and blue. Monitoring
the levels of each red, green and blue color channel makes it is easy to view color balance in the blacks,
mids and whites of the video signal. Parade Display enables you to identify details common to the red,
green and blue channels.

It's often important to make sure you're not clipping the video levels. Make sure the video is full level but
not clipped. You can turn on the GAMUT function, and any illegal levels will be highlighted in bright red,
so they are easy to see. Instructions for setting gamut limits can be found in the Error Logging Display
section of this manual. If you want to increase the video level, then make sure it doesn’t go above upper
RGB limit or you will encounter illegal levels. Some equipment won't let you generate illegal 100% RGB
levels, however other equipment will. Blackmagic UltraScope lets you see illegal levels whenever they occur.

lllegal video can also happen in blacks as well as whites. Some equipment produces black levels which
can be lowered below the black point of 0%. The levels will be shown as bright red if this falls below the
lower gamut limit and the GAMUT warning mode is enabled. If you observe illegal black levels, just add
some “lift” or gain to eliminate them but check the 100% graticule level to make sure the whole video
signal has not lifted and generated illegal colors in the whites.

To check levels, simply press the YUV or YUV+ button.

The COLOR setting switches the RGB display to color rather than traditional black and white. When the
COLOR setting is used with the YUV or YUV+ display, luma (brightness) remains white, B-Y (difference
between blue and luma) appears blue and R-Y (difference between red and luma) appears red. The COLOR
setting is not a professional setting and should usually be switched off, especially when showing video
to clients.
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Waveform Display on Windows can show Luminance,
Composite or Both views.

Waveform Display on Mac OS X always shows Luminance view.

Waveform Display

The Waveform Display is similar to traditional composite waveform monitors seen in many broadcast
studios. On Mac OS X, the Waveform Display always shows the luminance view and the B/W button is
permanently selected. On Windows, select B/W for the luminance only view, COMP for the composite
only view, and BOTH for the twin luminance and composite view.

Select B/W for the luminance view which provides a digitally encoded waveform similar to traditional
luminance waveform monitors. The luminance view is very useful when adjusting luma (brightness) levels
in animage. Turn on the GAMUT function, and any illegal luma levels will be highlighted in bright red, so
they are easy to see. Instructions for setting luma limits can be found in the Error Logging Display section
of this manual. Traditional luminance waveform monitors only supported composite analog standard
definition video. However UltraScope'’s luminance view works in high definition as well as standard definition,
so you have a consistent and easy way to adjust luma levels even when monitoring high definition digital
video formats!

For Windows users, the composite view is exciting because it's a fully digitally encoded composite
waveform view and similar to a traditional waveform monitor. This provides a much easier way to align
to test signals, such as color bars, because you can use the composite waveform exactly the same way
as it has always been used. Composite view also works in high definition, so you have a consistent and
traditional way to adjust video even when working in high definition!

When BOTH view is selected on a Windows PC, the composite and luminance waveforms display side by
side in a twin view. This is incredibly useful when adjusting video levels or color correcting. It's impossible
for a vectorscope to show which objects in the video have color because a vectorscope just shows what
colors are in the whole image and not which objects have color. When color correcting, you often need
to look for specific parts of the image, remove the color and produce a neutral state. This is because the
composite waveform is the same as the luminance signal but with chroma added.

Choosing this twin view makes it easy to identify similar items in the luminance and composite waveforms,
and if more blur or chroma is observed in the composite area, the item has color. If some part of the
video image is neutral gray, then it should look the same on both waveforms because no chroma will
be present. With the twin view, you can look around the waveform and see the levels of color or chroma
of various objects. As you color correct, the composite waveform will display more or less chroma in
the video signal. Now you can see if specific objects in the video image are color or black and white.
You can make technical and creative decisions using the Waveform Display.

When the Waveform display is zoomed in, you can toggle between COMP and B/W, and view the same
region of an image in the zoomed display.
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Vectorscope Display

Vectorscope Display

The Vectorscope Display uses a vector view to show the colors in a video signal. You can see color bar
video levels by using the color boxes in the graticule. All you need to do is select 75% or 100% color
bars, depending on the standard of color bar test signals used in your facility!

Some people think you can use a vectorscope to check for illegal levels. However this is not correct and
the Parade Display should be used, and set to RGB, for checking for illegal colors. The reason you cannot
use a vectorscope to check for illegal levels is that both chroma and luminance values are required. For
example, colors near the white or black points in video cannot be as saturated as the much stronger
colors, which can be used in the mid-grays. Because Vectorscope Display only shows colors, and not
luminance values, it cannot be used to check for illegal colors.

Vectorscope Display is the best tool for checking color levels from older, analog videotape where you
need to adjust chroma levels. Just play back the color-bar segment of the videotape, and then adjust
the chroma and hue settings, to set the colors of the video within the square boxes in the graticule.

Vectorscope Display is also perfect for color grading, as you can easily see if your video is correctly
white-balanced or if there is a color tint. If your video has a color tint, the Vectorscope display will drift
off-center, and you might see two center dots. Normally the blanking in the video signal will create a
dot in the center of the vector scope, and this is because the blanking in the video is black video without
any color. Blanking provides a useful reference point to help recognize areas of black video without any
color information.

If your video has a color tint, you should see the blacks move off-color and off-center. The degree of shift
represents the amount of color tint in your video and you can see the shift in both the white and black
details of your video. This makes Vectorscope Display valuable for removing color tint and regaining correct
white balance.

Vectorscope Display lets you push colors in your video to the limits, without accidentally adding unwanted
color tints to blacks and whites. While color balance can be monitored on both the RGB Parade Display
and Vectorscope Display, color balance issues will often be easier to see in Vectorscope Display.

When color correcting footage of skin tone, particularly faces, you will want to keep your warm color
saturation along a line at approximately 10 o'clock on the vectorscope. This is known as the "fleshtone line"
and is based on the color of blood beneath the skin's surface. The fleshtone line is therefore applicable
to all skin pigmentations and is the best way to ensure the skin tones of your talent look natural.
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Histogram Display

Histogram Display

Histogram Display is most familiar to graphic designers and camera operators. Histogram Display
shows the distribution of white to black information and lets you monitor how close the detail is to
being clipped off in the whites or blacks of the video. Histogram Display also lets you see the effects of
gamma changes in the video.

Black video is shown on the left of the display, and whites are shown on the right. All video should usually
be found between the 0% and 100% intervals of the Histogram Display. Your video is being clipped if it
moves below 0% or above 100%. Video clipping can be really bad, when you're on a shoot, as detail in the
blacks and whites must be preserved if you subsequently want to perform color-correction in a controlled
environment. When shooting, keep the video above the black clip, and below the white clip, so you can
have more freedom later to adjust colors without whites and blacks appearing flat and lacking in detail.

When color-correcting, you might decide to clip your video, and in which case Histogram Display will
show the effect of clipping the video, and how much it is being clipped. You can even use gamma to
create a similar look, with less clipping, while retaining more detail.

You cannot really use Histogram Display to check for illegal levels although you can use it to see illegal
blacks and whites. Histogram Display does not show colors and so the histogram might appear to show
legal levels, even though your video may contain illegal colors. Again, RGB Parade Display provides the
best way to watch out for illegal levels as it shows them in both the color and luminance elements of
the video signal.

The HIGH and LOW buttons simply control how bright the histogram appears on your computer display.
If you find the white area of the histogram is too bright in a dark studio, choose LOW for a more
comfortable brightness level.
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From the Histogram Display, select the Logging button to
switch to the Error Logging Display.

Error Logging Display

Error Logging records errors in video and audio and is indispensable when reviewing video and for
unattended operation. Errors may be logged for color, brightness or audio threshold levels as well as
loss of video signal, change of video format or audio silence. After setting the parameters which define
when an error should be logged, you can choose to start or stop error logging, save the log to a file, or
clear the log. These functions can be selected from the buttons in the Error Logging Display or from
the Error Logging pulldown menu.

Errors are recorded against timecode and time of day to make them easy to find. If the timecode is not
present, errors can be found by reviewing the time of day at which they were recorded. As computer
clocks can drift, itis a good idea to inspect the Date & Time settings on your computer, and set the clock
to synchronize with an Internet time server to ensure accurate time of day logging.

In the Full Screen view, Histogram Display and Error Logging Display share the same area of the
UltraScope interface. Select the LOGGING button, below the Histogram Display, to switch to the Error
Logging Display. Select the HISTOGRAM button, below the Error Logging Display, to switch back to
the Histogram Display. After quitting and reopening the UltraScope application, the last viewed display
will be made visible again, i.e. either Histogram or Error Logging.

In 2-up view, Histogram Display and Error Logging Display can be viewed simultaneously and so there
are no LOGGING or HISTOGRAM buttons.

When viewing the Error Logging Display for the first time, the display will initially be blank other than
for some column headings. Select the START button to commence logging. In Full Screen view, you
can switch back to the Histogram Display and UltraScope will continue to perform error logging until
you choose to stop it.

When error logging is being performed, the STOP button replaces the START button. When the STOP
button has been selected, you can choose to START again and any new errors will be appended to the
existing log. When error logging has been stopped, you can choose to SAVE the log to a CSV file or
alternatively CLEAR the log. The SAVE and CLEAR buttons will not appear if no errors have been recorded.
The CSV file can be analyzed in many applications including spreadsheet and database software.

By default, error logging is performed using the EBU-R103 standard which is set down by the European
Broadcasting Union. This standard is popular worldwide and is commonly used as a template for making
new error logging profiles.
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How to Customize Error Logging

To customize error logging, go to the Error Logging menu and choose Profiles to open the Error Logging
Profiles window. Saved profiles appear in the profile list at the left and the current active profile appears
in bold above the list.

The standard EBU-R103 profile cannot be deleted or modified and is grayed out. You can add a profile
by clicking the add (+) button and typing a name for your profile. The new profile will initially contain the
same parameters as the EBU-R103 profile but these can be changed as required.

Under the Gamut tab, upper and lower limits can be adjusted as a percentage of IRE units for RGB, Luma
and Chroma. Set the minimum time in milliseconds (ms) for which these conditions must be sustained
before being logged as errors. Set the percentage area, of pixels in error to total pixels in a frame, below
which errors can be ignored. The Area setting acts like sensitivity.

Under the Audio tab, the maximum audio level can be set in decibels (ABFS) as can the audio level below
which audio is regarded as silence. Set the minimum time in milliseconds (ms) for which these conditions
must be sustained before being logged as errors.

Under the Video tab, loss of video signal and change of video format can be logged as errors.
Under the Notes tab, write a brief description of the new profile to help distinguish it from other profiles.

To modify a new or existing profile, ensure it is selected and then change its parameters as desired.
Press Save to save these changes or choose Revert to leave the profile unchanged.

Choosing Save saves the changes to the profile but does not determine which profile is active. To activate
a profile, select it from the profile list and then choose Set Active.

You can delete a profile by selecting it in the profile list and clicking the delete () button.
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Audio Metering Display

Audio Metering Display shows you the audio levels in the embedded audio of the HyperDeck Studio
Pro's video signal. 8 channels of embedded audio from your HyperDeck Studio Pro are de-embedded
and then displayed in either dBFS or VU format. The VU button switches between dBFS and VU audio
metering standards.

dBFS s essentially a meter of the overall digital audio signal and is common on modern digital equipment.

The VU meter shows average signal levels, is easy to use and very common on older equipment. VU is
calibrated to the SMPTE recommendation of a 1 kHz tone test signal set to -20 dBFS.

The right hand audio scope can monitor two channels of audio. The audio scope presents audio in an X-Y
view so you can see audio balance issues, out of phase conditions and whether an audio track is mono
or stereo. Mono audio should appear as a single, vertical, “in phase” line. If the line is horizontal, then
your audio is “out of phase” and could cancel out (i.e. loss of audio) when received by downstream
equipment. Audio phase is one of the most common audio faults in large facilities, where cables can
be incorrectly connected.

When monitoring stereo signals, the line of the right hand audio scope fans out to represent the difference
between the left and right audio channels. The more stereo sound contained in the audio track, the
more circular the line will appear. If the audio contains minimal stereo content, then the scope will appear
more concentrated around the vertical axis.

While spoken dialog tends to appear as a vertical line, music with plenty of stereo content will puff out.
This is because mono audio is L+R, and will display on the vertical axis, whereas stereo content is L-R,
and will display on the horizontal axis to show the stereo difference.
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HD 1080i

Picture Display

01:15:16:22

Picture Display

The Picture Display is a handy confidence monitor so you can see the video that is being received
by Blackmagic UltraScope. The Picture Display has three settings: COLOR, B/W (black & white) and
BLUE (Blue Only).

Set to COLOR or B/W depending on the needs of your facility. Black & white is popular for use in
color-correction studios so clients don't get confused when seeing multiple color displays, and not
understanding which color display is the correct, color-calibrated display. You may wish to select B/W
so there is only a single calibrated color display in the room. The black & white display can also provide
a useful visual reference.

Blue Only is used with color bar test signals for setting hue on playback decks. When adjusting hue,
make sure all the blue bars are a constant brightness to attain the correct hue level.

Blue Only can also be used for evaluating noise levels in cameras and telecines. Blue has the least amount
of signal level, in a color video signal, and so is more susceptible to noise. The BLUE setting can provide
a good way to check on noise levels in a video signal.

The Picture Display will also decode RP-188 HD and VITC SD timecode information, from an SDI video
input signal, and display it on the right side of the display. If the timecode information is incorrect, check
your deck to ensure it is outputting the correct timecode signal encoded as VITC or RP188.

It is worth noting that some standard definition broadcast decks let you “re-stripe” the timecode track
independently of the VITC, which was encoded as part of the image. This meant the VITC could not be
changed without copying the video down another generation. Consequently some standard definition
decks had different timecode in the VITC to the normal LTC track on the SDI video output. It is always
worth checking master tapes if you think the displayed timecode is incorrect.

The Picture Display will also show timecode internally generated by your HyperDeck Studio Pro when
Generate is selected in the Ancillary Data>Timecode>Mode Select menu.

Lastly, the video standard is displayed on the left side of the Picture Display, so you can verify the video
standard being output by your HyperDeck Studio Pro. This information is great for independently checking
that the correct video standard is being output without having to use external monitoring equipment.
If the displayed video standard is not what you expected, you should check the output settings on
HyperDeck Studio Pro.
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Using Blackmagic Design Disk Speed Test

Blackmagic Disk Speed Test is a beautiful and fun to use application that measures the read and write
performance of storage media in video frame sizes. The use of video frame sizes provides accurate
measurement of how the disk storage will perform with video related applications.

If you have ever wondered whether your hard drive is suitable for playback (“read”) of a particular video
format, you can use Disk Speed Test to find out. With its easy to understand layout, it is now simple to
understand what performance you can get out of your media drives with a single click of the Start button!
Disk Speed Test will even show you how many streams of video your storage is capable of handling!

Disk Speed Test is included free with your HyperDeck and can also be downloaded from our website
free of charge.

Disk Speed Test takes the guess work out of configuring your storage system for optimal performance
for any job you will be doing.

Disk Speed Test settings are accessed by clicking on the Settings button, just above the Start button.
On Mac OS X, the same settings are also available from the Menu Bar at the top of your computer display.

Select Target Drive

Click Select Target Drive to choose the storage volume you wish to test. Ensure you have Read and Write
permissions for the selected volume as Disk Speed Test will write a temporary file to it. This file will be
automatically deleted when you quit Disk Speed Test.

Save Screenshot
After testing your disk storage, click Save Screenshot to save a screenshot of the results to a chosen location.

Stress

Lower stress settings may be chosen if you want to demonstrate the speed of disk storage quickly.
The 1 GB option would be a good choice on a trade show booth to rapidly show the read and write
performance of a disk array even though the results might not be quite as accurate as when the 5 GB
option is selected.

Disk Speed Test limits each write operation to a maximum of 8 seconds and each read operation to a
maximum of 8 seconds so you do not have to wait long to obtain results.

Disk Speed Test Help
Click Disk Speed Test Help to launch the PDF manual for Disk Speed Test.

About Disk Speed Test
About Disk Speed Test displays which version of the Disk Speed Test you are running.
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Disk Speed Test

._I_\_“\_
P

WRITE

Disk Speed Test interface during a test

Start

Once you have chosen the desired settings, click the Start button to commence the disk speed test.
Disk Speed Test will write a temporary file to the selected target drive. When the file has finished writing,
or when 8 seconds has elapsed, Disk Speed Test will stop writing and start reading back the temporary
file from the drive.

Disk Speed Test will continue writing and reading the nominated sized stress file until you stop the test
by clicking the Start button again.

Will it Work?
The “Will it Work?" panel can help to identify video formats where the Read performance might be
significantly different to the Write performance. These differences might mean that you can capture a
video format but not play it back in real time or else you can play back a video format but not capture
itin real time.

The “Will it Work?” panel shows common video formats and instantly displays a check mark or cross to
show if the disk performance will be adequate for the desired video format. We suggest you allow Disk
Speed Test to perform several test cycles to help reveal any video formats for which the disk storage
performance might be marginal. If you observe a check mark and a cross switching between each other
for a video format, this would indicate that the disk storage cannot reliably support the video format.

The “How Fast?” results panel shows the frame rates your drive can achieve in frames per second and
should be read in conjunction with the “Will it Work?" panel. If the "Will it Work?” panel shows a green
check mark for 1080p@59.94fps in 10 Bit YUV 4:2:2, but the “How Fast?” panel shows that a maximum of
60fps will be supported, the disk storage performance is too marginal to be reliable.

How Fast?

After each Read or Write test, the results will be displayed in the “How Fast?” panel. The “How Fast?”
results panel also enables you to see how many streams of video can be supported by your disk storage.
If the result for “HD 1080" is 70, you can run up to 70 frames of HD 1080 video per second.

This storage speed is capable of supporting the following video formats:

* 2 simultaneous streams of 1080i50 video at 25 fps per stream
* 1 stream of 1080p50 video at 50 fps per stream
1 stream of 1080p59.94 video at 59.94 fps per stream
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Blackmagic HyperDeck Ethernet Protocol

Version 1.3

The Blackmagic HyperDeck Ethernet Protocol is a text based protocol accessed by connecting to TCP
port 9993 on a HyperDeck Studio or HyperDeck Studio Pro. If you are a software developer you can
use the protocol to construct devices that integrate with our products. Here at Blackmagic Design our
approach is to open up our protocols and we eagerly look forward to seeing what you come up with!

Protocol Commands

Command

help or ?

remote

remote: enable: true

remote: enable: false

remote: override: true

remote: override: false

quit

ping

preview: enable: true

preview: enable: false

play

play: speed: {% normal speed}

play: loop: true

play: single clip: true
record

record: name: “{clip name}”
stop

goto: clip id: {clip ID}

goto: clip: {"start”, “end"”}

Command Description

Provides help text with all commands and parameters.
Queries the state of HyperDeck’s remote control mode.
Enables remote control.

disables remote control.

Turns remote override on.

Turns remote override off.

Disconnects HyperDeck server.

Determines HyperDeck server is responding.

Switches to HyperDeck preview mode.

Switches to HyperDeck output mode.

Starts playback all remaining clips on the timeline then stop.

Starts playback at a specified speed in percentage between
-1600 and 1600.

Starts playback in looping fashion.

Starts playback the remaining of the current clip then stop.
Starts recording.

Starts recording a clip using a specified clip name.

Stops playback or recording.

Goes to start of specific clip.

Goes to start or end of current clip.
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Command
goto: timeline: {"start”, “end”}
goto: timecode: {timecode}

goto: timecode: {"+", "-"}
{duration in timecode}

commands

notify

notify: transport: true
notify: transport: false
notify: slot: true

notify: slot: false

notify: remote: true
notify: remote: false
notify: configuration: true
notify: configuration: false
device info

slot info

slot info: slot id: {slot ID}
clips get

transport info
configuration

configuration: video input:
{"SDI”, “"HDMI", “"component”}

configuration: audio input:
{"embedded”, “XLR", "RCA"}

configuration: file format:
{File format}

slot select: video format:
{Video format}

slot select: slot id: {slot ID}

Command Description
Goes to start of first clip or end of last clip.
Goes to specified timecode

Moves forward or back a duration in timecode

Lists all supported commands in an XML format.
Queries the current state of all notifications.
Enables transport notifications.

Disables transport notifications.

Enables slot notifications.

Disables slot notifications.

Enables remote notifications.

Disables remote notifications.

Enables configuration notifications.

Disables configuration notifications.

Provides information about the connected device.
Provides information about the current active slot.
Provides information about a specified slot.
Provides information for each available clip.
Provides information for the state of the transport.
Queries the current configuration.

Configures video input.
Configures audio input.

Configures current file format.

Reloads timeline with all clips of the specified video format.

Switches to the specified slot.
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Command Combinations
You can combine the parameters into a single command, for example:

play: speed: 200 loop: true single clip: true
Or for configuration:
configuration: video input: SDI audio input: XLR
Or to switch to the second disk, but only play NTSC clips:
slot select: slot id: 2 video format: NTSC
Using XML
While you can use the Terminal to talk to HyperDeck, if you are writing software you can use XML to confirm
the existence of a specific command based on the firmware of the HyperDeck you are communicating

with. This helps your software user interface adjust to the capabilities of the specific HyperDeck model
and software version.

Protocol Details

Connection
The HyperDeck Ethernet server listens on TCP port 9993.
Basic syntax

The HyperDeck protocol is a line oriented text protocol. Lines from the the
server will be separated by an ascii CR LF sequence. Messages from the client
may be separated by LF or CR LF.

New lines are represented in this document as a "+'" symbol.

Command syntax

Command parameters are usually optional. A command with no parameters
is terminated with a new line:

{Command name}+
If parameters are specified, the command name is followed by a colon, then

pairs of parameter names and values. Each parameter name is terminated
with a colon character:

{Command name}: {Parameter}: {Value} {Parameter}: {Value} ...«
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Response syntax

Simple responses from the server consist of a three digit response code and
descriptive text terminated by a new line:

{Response code} {Response text}+

If a response carries parameters, the response text is terminated with a colon,
and parameter name and value pairs follow on subsequent lines until a blank

line is returned:

{Response code} {Response text}:+

{Parameter}: {value}+!

{Parameter}: {value}+!

P

Successful response codes

A simple acknowledgement of a command is indicated with a response code

of 200:

200 ok

Other successful responses carry parameters and are indicated with response

codes in the range of 201 to 299.

Failure response codes

Failure responses to commands are indicated with response codes in the

range of 100 to 199:

100
101
102
103
104
105
106
107
109
110

syntax error
unsupported parameter
invalid value
unsupported

disk full

no disk

disk error

timeline empty

out of range

no input
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111 remote control disabled
120 connection rejected

150 invalid state

Asynchronous response codes

The server may return asynchronous messages at any time. These responses
are indicated with response codes in the range of 500 to 599:

5xx {Response Text}:+
{Parameter}: {value}+!

{Parameter}: {value}+!
o

Connection response
On connection, an asynchronous message will be delivered:
500 connection info:¢!
protocol version: {Version}+
model: {Model Name}+
o

Connection rejection
Only one client may connect to the server at a time. If other clients attempt to
connect concurrently, they will receive an error and be disconnected:

120 connection rejected+
Timecode syntax
Timecodes are expressed as non-drop-frame timecode in the format:
HH:MM:SS:FF
Handling of deck "remote" state
The "remote" command may be used to enable or disable the remote control

of the deck. Any attempt to change the deck state over ethernet while
remote access is disabled will generate an error:

111 remote control disabled+’

To enable or disable remote control:

remote: enable: {"true", "false"} +
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The current remote control state may be overridden allowing remote access
over ethernet irrespective of the current remote control state:

remote: override: {"true", "false"} +

The override state is only valid for the currently connected ethernet client and
only while the connection remains open.

The "remote" command may be used to query the remote control state of
the deck by specifying no parameters:

remote+!
The deck will return the current remote control state:

210 remote info:¢!

enabled: {"true", "false"}+

override: {"true", "falgse"}+

P

Asynchronous remote control information change notification is disabled by
default and may be configured with the "notify" command. When enabled,
changes in remote state will generate a "510 remote info:"asynchronous
message with the same parameters as the "210 remote info:" message.

Closing connection
The "quit" command instructs the server to cleanly shut down the connection:
quit+!
Checking connection status

The "ping" command has no function other than to determine if the server is
responding:
ping+
Getting help
The "help" or "?" commands return human readable help text describing all
available commands and parameters:
help+
Or:
¢
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The server will respond with a list of all supported commands:
201 help:+
{Help Text}+
{Help Text}+!
|

Switching to preview mode

The "preview" command instructs the deck to switch between preview mode
and output mode:

preview: enable: {"true", "false"}+!
Playback will be stopped when the deck is switched to preview mode.
Capturing will be stopped when the deck is switched to output mode.
Controlling device playback
The "play" command instructs the deck to start playing:
play+

The play command accepts a number of parameters which may be used
together in most combinations.

By default, the deck will play all remaining clips on the timeline then stop.
The "single clip" parameter may be used to override this behaviour:
play: single clip: {"true", "false"}«
By default, the deck will play at normal (100%) speed. An alternate speed
may be specified in percentage between -1600 and 1600:
play: speed: {% normal speed}+
By default, the deck will stop playing when it reaches to the end of the
timeline. The "loop" parameter may be used to override this behaviour:
play: loop: {"true", "false"}+
By default, the deck will start playing from the current position on the

timeline. The “start” parameter may be specified to override the start-point
for playback:

play: start: {timecode}+
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If loop mode is set, the playback loop will be between:
the "start" position and the end of timeline for play forward,
the "start" position and the start of timeline for play backward.
By default the deck will continue playing until the end of the timeline. The

"end” parameter may be used to halt playback at the frame before the
specified timecode:

play: end: {timecode}+!

If loop mode is set, the playback loop will be between:
the start of timeline and the "end" position for play forward,
the end of timeline and the "end" position for play backward.

Note that the "end" position must be:

beyond the current/or start position on timeline for play forward,
before the current/or start position on timeline for play backward.

The “duration” parameter may be used instead of the “end” parameter to
halt playback after a duration specified in timecode format:

play: duration: {timecode}+

These three parameters are not compatible with the “single clip” parameter.

Stopping deck operation

The "stop" command instructs the deck to stop the current playback or capture:

stop+

Changing timeline position

The "goto" command instructs the deck to switch to playback mode and
change its position within the timeline.
To go to the start of a specific clip:

goto: clip id: {Clip ID}+!
To move forward/back {count} clips from the current clip on the current
timeline:

goto: clip id: +/-{count}+

Note that if the resultant clip id goes beyond the first or last clip on timeline,
it will be clamp at the first or last clip.
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To go to the start or end of the current clip:
goto: clip: {"start", "end"}+«
To go to the start of the first clip or the end of the last clip:
goto: timeline: {"start", "end"}«
To go to a specified timecode:
goto: timecode: {timecode}+
To move forward or back a specified duration in timecode:
goto: timecode: {"+", "-"}{duration in timecode}+
Note that only one parameter/value pair is allowed for each goto command.
Enumerating supported commands and parameters

The "commands" command returns the supported commands:
commands+

The command list is returned in a computer readable XML format:

212 commands:

<commands>+
<command name=".."><parameter name:"..."/>...</command>‘—I
<command name=".."><parameter name:"..."/>...</comma.nd>‘—I
</commands>+!
Pl

More XML tokens and parameters may be added in later releases.
Controlling asynchronous notifications

The "notify" command may be used to enable or disable asynchronous
notifications from the server. To enable or disable transport notifications:

notify: transport: {"true", "false"}+

To enable or disable slot notifications:

notify: slot: {"true", "false"}+

To enable or disable remote notifications:

notify: remote: {"true", "false"}«
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To enable or disable configuration notifications:
notify: configuration: {"true", "false"}«

Multiple parameters may be specified. If no parameters are specified, the
server returns the current state of all notifications:

209 notify:+
transport: {"true", "false"}+

slot: {"true", "false"}«

remote: {"true", "false"}+
configuration: {"true", "false"}«!
o

Retrieving device information

The "device info" command returns information about the connected deck
device:

device info+!

The server will respond with:
204 device info:+!
protocol version: {Version}+
model: {Model Name}+!
unique id: {unique alphanumeric identifier}+
|
Retrieving slot information

The "slot info" command returns information about a slot. Without
parameters, the command returns information for the currently selected slot:

slot info+

If a slot id is specified, that slot will be queried:
slot info: slot id: {Slot ID}+

The server will respond with slot specific information:
202 slot info:¢!
slot id: {Slot ID}«
status: {"empty", "mounting", "error", "mounted"}+«

volume name: {Volume name}+!
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recording time: {recording time available in seconds}+
video format: {disk's default video format}«
P

Asynchronous slot information change notification is disabled by default and
may be configured with the "notify" command. When enabled, changes in
slot state will generate a "502 slot info:" asynchronous message with the same
parameters as the "202 slot info:" message.

Retrieving clip information

The "disk list" command returns the information for each playable clip on a
given disk. Without parameters, the command returns information for the

current active disk:
disk list¢!
If a slot id is specified, the disk in that slot will be queried:
disk list: slot id: {Slot ID}+
The server responds with the list of all playable clips on the disk in the format
of: Index, name, formats, and duration in timecode:
206 disk list:<!
slot id: {Slot ID}+!
{clip index}: {name} {file format} {video format} {Duration
timecode}+
{clip index}: {name} {file format} {video format} {Duration

timecode}+

o
Note that the clip index starts from 1.
Retrieving clip count
The "clips count" command returns the number of clips on the current timeline:
clips count +
The server responds with the number of clips:
214 clips count: <
clip count: {Count}+
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Retrieving timeline information

The "clips get" command returns information for each available clip, for a
given range in timecode, on the current timeline. Without parameters, the
command returns information for all clips on timeline:

clips get+
If parameters "in: timecode" and "out: timecode" are specified, the
command returns information for clips within the specified range.
If "out: " is not specified, it only returns the information of the clip containing
in "in: " point.
clips get: in: {timecode} out: {timecode}+
The server responds with a list of clip IDs, names and timecodes:
205 clips info:¢
clip count: {Count}+
{clip ID}: {Name} {Start timecode} {Duration timecode}+
{clip ID}: {Name} {Start timecode} {Duration timecode}+

P

Note that the clip list format has changed incompatibly in protocol version
1.1,

i.e., Start timecode information field is inserted to each clip information line.
Retrieving transport information

The "transport info" command returns the state of the transport:

transport info ¢

The server responds with transport specific information:
208 transport info:¢
status: {"preview", "stopped", "play", "forward", "rewind",
"jog", "shuttle","record"}‘-'
speed: {Play speed between -1600 and 1600 %}+!
slot id: {Slot ID or "none"}+!
display timecode: {timecode}+

timecode: {timecode}+



Yl Developer Information

clip id: {Clip ID or "none"}+«
video format: {Video format}+!
loop: {"true", "false"}«

o

The "timecode" value is the timecode within the current timeline for playback
or the clip for record. The "display timecode" is the timecode displayed on
the front of the deck. The two timecodes will differ in some deck modes.

Asynchronous transport information change notification is disabled by
default and may be configured with the "notify" command. When enabled,
changes in transport state will generate a "508 transport info:" asynchronous
message with the same parameters as the "208 transport info:" message.

Video Formats

The following video formats are currently supported on HyperDeck Studio:
NTSC, PAL, NTSCp, PALp
720p50, 720p5994, 720p60
1080p23976, 1080p24, 1080p25, 1080p2997, 1080p30
1080i50, 1080i5994, 1080i60
HyperDeck Studio Pro adds supports for 4k formats:

4Kp23976, 4Kp24, 4Kp25, 4Kp2997, 4Kp30
Video format support may vary between models and software releases..

File Formats

The HyperDeck Studio and HyperDeck Studio Pro currently support the
following file formats:

QuickTimeUncompressed

QuickTimeProResHQ

QuickTimeProRes

QuickTimeProResLT

QuickTimeProResProxy

QuickTimeDNxHD220

DNxHD220

Supported file formats may vary between models and software releases.
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Querying and updating configuration information

The "configuration” command may be used to query the current
configuration of the deck:

configuration+

The server returns the configuration of the deck:

211 configuration:+

audio input: {"embedded", "XLR", "RCA"}«

video input: {"SDI", "HDMI", "component"}+

file format: {File format}+

o
One or more configuration parameters may be specified to change the
configuration of the deck.
To change the current video input:

configuration: video input: {"SDI", "HDMI", "component"}+
Valid video inputs may vary between models. To configure the current audio
input:

configuration: audio input: {"embedded", "XLR", "RCA"}+!
Valid audio inputs may vary between models.
To configure the current file format:

configuration: file format: {File format}+
Note that changes to the file format may require the deck to reset, which will

cause the client connection to be closed. In such case, response code 213 will
be returned (instead of 200) before the client connection is closed:

"213 deck rebooting"

Asynchronous configuration information change notification is disabled by
default and may be configured with the "notify" command. When enabled,
changes in configuration will generate a "511 configuration:" asynchronous
message with the same parameters as the "211 configuration:" message.

Selecting active slot and video format

The "slot select” command instructs the deck to switch to a specified slot, or/
and to select a specified output video format.
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To switch to a specified slot:

slot select: slot id: {slot ID}+

To select the output video format:
slot select: video format: {video format}+

Either or all slot select parameters may be specified. Note that selecting video
format will result in a rescan of the disk to reconstruct the timeline with all clips
of the specified video format.

Clearing the current timeline
The "clips clear" command instructs the deck to empty the current timeline:
clips clear+!
The server responds with
200 ok+!
Adding a clip to the current timeline
The "clips add:" command instructs the deck to add a clip to the current timeline:
clips add: name: {"clip name"}«
The server responds with
200 ok+!
or in case of error

1xx {error description}+
Configuring the watchdog

The “watchdog” command instructs the deck to monitor the connected client
and terminate the connection if the client is inactive for at least a specified
period of time.

To configure the watchdog:
watchdog: period: {period in seconds}+
To avoid disconnection, the client must send a command to the server at least

every {period} seconds. Note that if the period is set to 0 or less than O, connection
monitoring will be disabled.



Getting Help

The fastest way to obtain help is to go to the Blackmagic Design online support pages and check the
latest support material available for your HyperDeck.

Blackmagic Design Online Support Pages

The latest manual, software and support notes can be found at the Blackmagic Design support center at
www.blackmagicdesign.com/support.

Contacting Blackmagic Design Support

If you can't find the help you need in our support material, please use the "Send us an email" button on
the support page to email a support request. Alternatively, click on the "Find your local support team"
button on the support page and call your nearest Blackmagic Design support office.

Checking the Software Version Currently Installed

To check which version of HyperDeck Utility software is installed on your computer, open the About
Blackmagic HyperDeck Utility window.

* On Mac OS X, open Blackmagic HyperDeck Utility from the Applications folder. Select About
Blackmagic HyperDeck Utility from the application menu to reveal the version number.

= On Windows, open Blackmagic HyperDeck Utility from your Start menu or Start Screen.
Click on the Help menu and select About Blackmagic HyperDeck Utility to reveal the
version number.

How to Get the Latest Software Updates

After checking the version of HyperDeck Utility software installed on your computer, please visit the
Blackmagic Design support center at www.blackmagicdesign.com/support to check for the latest
updates. While it is usually a good idea to run the latest updates, it is a wise practice to avoid updating
any software if you are in the middle of an important project.


http://www.blackmagicdesign.com/support
http://www.blackmagicdesign.com/support
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CAUTION!

RISK OF ELECTRIC
SHOCK-DO NOT OPEN!

100-240V 1.7A 50-60Hz Fuse T5AL

Caution label on rear panel
Warnetikett auf der Rickseite

Avertissement sur le panneau arriére

Caution: Risk of Electric Shock

On HyperDeck Studio Pro's rear panel you will see a yellow warning label marked ‘Caution: Risk of Electric
Shock’. This is intended to warn users that there may be the presence of uninsulated “dangerous”
voltage within HyperDeck Studio Pro’s enclosure which may be of sufficient magnitude to constitute a
risk of electric shock to the user. Blackmagic Design advises you not to open the HyperDeck Studio Pro
unit, but rather contact your nearest Blackmagic Design service center should assistance be required.

Achtung: Stromschlaggefahr

Auf der HyperDeck Studio Pro-Riickseite befindet sich ein gelbes Warnetikett mit der Aufschrift 'Caution:
Risk of Electric Shock'. Dieses warnt den Benutzer vor einer méglichen, nicht isolierten, "geféhrlichen”
Spannung innerhalb des HyperDeck Studio Pro-Gehéuses, die einen Elektroschock verursachen kann.
Blackmagic Design empfiehlt das Gehduse des HyperDeck Studio Pro nicht selbst zu &ffnen, sondern
bei Hilfebedarf das nadchstgelegene Blackmagic Design Servicecenter zu kontaktieren.

Attention: Risque de choc électrique

Sur le panneau arriére du HyperDeck Studio Pro, vous verrai une étiquette d'avertissement de couleur
jaune sur laquelle est inscrit « Attention : Risque de choc électrique ». Cette mise en garde est destinée
a avertir les utilisateurs de la présence possible d’'une tension « dangereuse » non isolée a l'intérieur du
boitier du HyperDeck Studio Pro, laquelle tension pouvant avoir une magnitude suffisante pour constituer
un risque de choc électrique a l'utilisateur. Blackmagic Design vous déconseille donc d'ouvrir I'unité
HyperDeck Studio Pro, et vous recommande de contacter votre centre de service Blackmagic Design
le plus proche en cas de nécessité.



rq \Narranty

12 Month Limited Warranty

Blackmagic Design warrants that this product will be free from defects in materials and workmanship for
a period of 12 months from the date of purchase. If a product proves to be defective during this warranty
period, Blackmagic Design, at its option, either will repair the defective product without charge for parts
and labor, or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the
defect before the expiration of the warranty period and make suitable arrangements for the performance
of service. The Customer shall be responsible for packaging and shipping the defective product to a
designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer
shall be responsible for paying all shipping charges, insurance, duties, taxes, and any other charges for
products returned to us for any reason.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or
inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under
this warranty: a) to repair damage resulting from attempts by personnel other than Blackmagic Design
representatives to install, repair or service the product, b) to repair damage resulting from improper
use or connection to incompatible equipment, ¢) to repair any damage or malfunction caused by the
use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or
integrated with other products when the effect of such a modification or integration increases the time
or difficulty of servicing the product. THISWARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF
ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
BLACKMAGIC DESIGN'S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE
WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC
DESIGN IS NOT LIABLE FOR ANY ILLEGAL USE OF EQUIPMENT BY CUSTOMER. BLACKMAGIC IS
NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS PRODUCT. USER OPERATES THIS
PRODUCT AT OWN RISK.

© Copyright 2013 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, "HDLink’, 'Workgroup Videohub’, ‘Multibridge

Pro’, 'Multibridge Extreme’, ‘Intensity’ and 'Leading the creative video revolution’ are registered trademarks in the US and other countries.
All other company and product names may be trade marks of their respective companies with which they are associated.
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